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WARNING 
 
 
To ensure the equipment described by this User Manual, as well as the equipment connected to 
and used with it, operates satisfactorily and safely, all applicable local and national codes that 
apply to installing and operating the equipment must be followed. This includes the National 
Electric Code in the USA and other applicable legislation, regulations, and codes in practice 
elsewhere. Since codes can vary geographically and can change with time, it is the user’s 
responsibility to determine which standards and codes apply, and to comply with them. 
 
FAILURE TO COMPLY WITH APPLICABLE CODES AND STANDARDS CAN RESULT IN 
DAMAGE TO EQUIPMENT AND/OR SERIOUS INJURY TO PERSONNEL. 
 
Persons supervising and performing installation or maintenance must be suitably qualified and 
competent in these duties, and should carefully study this User Manual and any other manuals 
referred to by it prior to installation and/or operation of the equipment. 
 
 
The contents of the User Manual are believed to be correct at the time of printing; however, no 
responsibility is assumed for inaccuracies. In the interests of a commitment to a policy of 
continuous development and improvement, the manufacturer reserves the right to change the 
specification of the product or it’s performance or the contents of the User Manual without notice. 
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This section describes the features of the HSL-CCSD1 Crown Cork & 
Seal Decorator High Speed Front End. This includes the functional 
description, alarms detected, etc. 
 
 
________________________________________________________ 
1.1 FEATURES 
 
• Performs high speed control functions of Crown Cork & Seal 

Decorator to speeds in excess of 2000 CPM. This includes 
detection of mis-loaded cans, damaged can blow-off, speed 
compensated print and varnish trip, and single space pin chain 
(linear vacuum conveyor) blow-off. 
 

• High speed front-end upgrade package which interfaces with 
existing control system. 
 

• Accurate damaged can blow-off prior to the print station 
eliminates cut blankets. 
 

• Speed compensated print trip and varnish trip control eliminates 
inside deco and varnish problems at all speeds (zero to 
2000CPM). 
 

• Accurate speed compensated single space pin chain (linear 
vacuum conveyor) blow-off reduces scrap and eliminates silver 
and partially printed cans down the line. 
 

• Single select-a-can QC pin chain blow-off allows operator to blow 
off a can from a selected spindle (or blanket) to verify print quality 
of each blanket with machine running at full production speeds. 

 
• Alarm detection: infeed track jam and timing signal fail detection. 

 
• Data Acquisition:  

1. Total number of good cans printed 
2. Total number of blow-offs 
3. Total trips per side (drive and offside) 
4. Trips per spindle per side (for both current shift and last shift) 
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• Built-in 2 Line X 40 character sealed display with 24 key 
membrane keypad allows local viewing of collected data (can 
count, blow-off count, trips per spindle) by operator and set-up of 
all user variables (passcode protected or key switch enabled) by 
authorized personnel. 

 
• Interfaces directly with machine mounted resolver, no can/no print 

sensors (both drive and offside) and all trip and blow-off 
solenoids. 

 
• Based on high performance M4503 PLC/PLS module which 

allows easy trouble-shooting and user customization using 
SYSdev (DOS-based) programming package. 

 
• Built-in PLS provides all machine timing, eliminating need for an 

additional PLS. 
 
 
________________________________________________________ 
1.2 FUNCTIONAL DESCRIPTION 
 
The HSL-CCSD1 Decorator High Speed Front End is an electronic 
upgrade for the Crown Cork & Seal decorator which:  
• Detects miss-loaded cans 
• Performs speed compensated print and varnish trip 
• Single space pin chain (linear vacuum conveyor) blow-off at 

speeds in excess of 2000 CPM  
• Select-A-Can pin chain blow-off for print quality verification of 

each blanket 
 
Alarm detection is provided including:  
• Infeed track jam 
• Timing signal failure 
 
Data collection (both for the current shift and previous (last) shift) 
includes:  
• Total good can count 
• Blow-off counts 
• Trips (misloads) per side 
• Trips (misloads) per spindle per side   



SECTION 1 
GENERAL DESCRIPTION 

 
HSL-CCSD1 User’s Manual SYSTEMS Electronics Group 

 
- 3 - 

The package interfaces directly to:  
• Machine mounted resolver 
• No can/no print sensors 
• Trip and blow-off solenoids 
• Host PLC via discrete DC I/O 
 
The package is not a dedicated “black box”, but is instead 
implemented using the high performance SYSTEMS M4503 
PLC/PLS module. This allows easy customization by either SEA or 
the end user. The M4503 module is programmed using the DOS-
based SYSdev programming package. This allows the module to be 
programmed in any combination of Ladder or High-level (subset of 
“C”), as well as perform on-line monitoring and trouble-shooting. The 
M4503 module incorporates a built-in PLS which interfaces directly 
with the machine mounted resolver and provides all machine timing, 
eliminating the need for an external PLS. 
 
 
________________________________________________________ 
1.3 SPEED COMPENSATED TRIP CONTROL 
 
Speed compensated trip control (at speeds in excess of 2000 CPM) is 
incorporated to compensate for the response time of the trip 
solenoid/cylinder. The print (or varnish) is always extended or 
retracted such that a miss-loaded mandrel is not printed (or varnished) 
regardless of machine speed. 
 
This is achieved by implementing a speed compensation algorithm 
that “leads” the trip point by the response time of the print 
solenoid/cylinder. The control is capable of “leading” the trip point by 
up to one station (60msec at 2000 CPM). 
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________________________________________________________ 
1.4 BAD CAN AND SELECT-A-CAN PIN CHAIN BLOW-OFF 
 
Both the bad can pin chain blow-off and select-a-can pin chain (linear 
vacuum conveyor) blow-off incorporate speed compensation to 
compensate for the response time of the blow-off solenoids regardless 
of machine speed. This allows accurate rejection of a single can (one 
from each side simultaneously) from the pin chain at speeds in excess 
of 2000 CPM. 
  
The select-a-can feature allows the user to dial in a mandrel number, 
(either at a remote PB station or from the keypad of the HSL-CCSD1) 
and blow-off one can printed on that mandrel. Mandrels 1 through 24 
can be individually blown-off this way to verify the print quality of 
each mandrel. Two other select-a-can blow-off modes are also 
available: 8 and 24 can blow-off. The 8 can mode blows off 8 
consecutive cans printed on blankets 1 through 8. The 24 can mode 
blows off 24 consecutive cans printed on all 24 mandrels, starting 
with mandrel 1. 
 
The following variables can be set by the user for the bad can blow-
off:  
• Number of cans from machine to blow-off port (up to 999) 
• Number of cans to blow-off for each misload (usually set to one 

for single can blow-off) 
• The “on” and “off” solenoid response time (used by the speed 

compensation algorithm) 
 
The following variables can be set by the user for the select-a-can 
blow-off:  
• 1 to 24 shift offset (this is used to match the actual mandrel 

number to the selected mandrel number) 
• The “on” and “off” solenoid response times 
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________________________________________________________ 
1.5 ALARM DETECTION 
 
The package detects the following alarms: 
  
Infeed Track Jam: The infeed track jam alarm occurs when 6 
consecutive empty mandrels are detected on either side by the “no 
can/no print sensors” after the can gate is opened. 
 
Timing Signal Fail: The timing signal fail occurs when any of the 
timing signals generated in the PLS section fail to change state 
periodically while the machine is running. 
 
The above alarms are available to the host PLC via discrete outputs. 
These should be used to stop the machine and indicate the problem 
when any one of the alarms occurs. 
 
 
________________________________________________________ 
1.6 DATA COLLECTION 
 
The following data is collected for both the current shift and previous 
(last) shift: 
 
1) Total number of good cans printed 
2) Total number of cans blown-off 
3) Total number of bad cans (cans blown-off because of misloads) 
4) Total number of restart blow-offs 
5) Total number of manual blow-offs 
6) Total number of select-a-can QC blow-offs 
7) Total trips per side (drive and offside) 
8) Total trips per spindle per side (for each spindle) 
 
This data can be viewed on the Keypad/Display. The information is 
updated (“current” shift transferred to “Last” shift) based on the 
change of state of a discrete input. This can be activated on an 8 or 12 
hour shift basis or alternatively could be activated manually on a label 
run basis depending on the user's preference. 
 
In addition to the shift data collection, a separate buffer is available to 
collect trips per spindle per side counts as a diagnostics aid for 
trouble-shooting a loading problem on a specific mandrel. Unlike the 
shift data, these counts can be reset manually at will. 
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The standard HSL-CCSD1 package is provided for back-panel 
mounting inside the existing user's control cabinet. In addition, the 
HSL-CCSD1 can be purchased in a self contained NEMA 12 
enclosure for mounting adjacent to the existing control cabinet by 
specifying part number HSL-CCSD1-ENCL. 
 
 
________________________________________________________ 
2.1 WHAT’S INCLUDED 
 
Depending on which package is purchased, verify that the following 
items are included when unpacking the HSL-CCSD1: 
 
 
________________________________________________________ 
2.1.1 HSL-CCSD1 (for back-panel mounting) 
 
1ea. HSL-CCSD1 back-panel for mounting in the existing user's 

control cabinet including the following: 
 

1ea. M4500 PLC/PLS module 
1ea. P4500 Power Supply 
1ea. D4591 Display with ribbon cable for mounting in the 

existing control cabinet door 
1ea. HSL-CCSD1 User's Manual 
1ea. M4500 User's Manual 
1ea. HSL-CCSD1 Program Disk 

 
 
________________________________________________________ 
2.1.2 HSL-CCSD1-ENCL (with NEMA 12 enclosure) 
 

1ea. HSL-CCSD1 NEMA 12 enclosure including the 
following: 

1ea. M4500 PLC/PLS module 
1ea. P4500 Power Supply 
1ea. D4591 Display/Keypad 
1ea. HSL-CCSD1 User's Manual 
1ea. M4500 User's Manual 
1ea. HSL-CCSD1 Program Disk 
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________________________________________________________ 
2.1.3 HSL-CCSD1 OPTIONS 
 
The following items can be purchased separately as required or 
desired. All items are compatible with both the back-panel mountable 
package or the NEMA 12 enclosed package: 
 

1ea. HSL-QCSTA Remote Select-A-Can PB station 
1ea. HSL-DSP Remote RPM/Position Display 
1ea. RSV34-MS1 Resolver 
1ea. RSV-RSCBLE-XX Resolver Cable 

 
 
________________________________________________________ 
2.2 POWER REQUIRED 
 
The HSL-CCSD1 is powered from 115VAC/230VAC 50/60HZ and 
+24VDC. The 115VAC/230VAC is used to power the HSL-CCSD1 
module while the +24VDC is used to power the +24VDC I/O 
(sensors, trip and blow-off solenoids).  
 
Note: +24VDC solenoids must be used for all trip and blow-off 
solenoids. These provide a much more consistent and repeatable 
response time than 115VAC solenoids. Assuming +24VDC solenoids 
were used in the existing system, the +24VDC current required by the 
HSL-CCSD1 is no more than the existing systems +24VDC current 
requirement, therefore the existing +24VDC power supply should be 
adequate. 
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________________________________________________________ 
2.3 MOUNTING AND WIRING THE HSL-CCSD1 
 
If installing the HSL-CCSD1 package mounted in the NEMA 12 
enclosure, mount the HSL-CCSD1 NEMA 12 enclosure in proximity 
to the existing control cabinet.  If installing the HSL-CCSD1-BP 
package, mount the back-panel in the existing control cabinet.  
 
Referring to the figure below create a cut-out in the existing control 
cabinet door and mount the D4591 display.  
 

 

 
D4591 Recommended Panel Door Cut-out 

 
 
Note: The D4591 must be located within 6 feet of the M4500 module 
to avoid EMI pick-up on the Display ribbon cable. Connect the ribbon 
cable from the M4500 module to the D4591 module. 
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Referring to the electrical control schematic at the back of this 
manual, wire the HSL-CCSD1 to the existing control system as 
follows: 
 
Note:  Keep all +24VDC wiring, resolver cable, and sensor cable 
wiring away from high voltage wiring. Wire the machine mounted 
resolver directly to the 8-pin resolver input connector on the M4500.  
 
1) Incoming Power: 115VAC-230VAC to FU1, neutral to 900 and 

ground to GND. +24VDC to 501 and common to 500. 
 
2) Interlocks from existing control system to HSL-CCSD1 (terminals 

I10 through I20). 
 
3) Interlocks to existing control system from HSL-CCSD1 (terminals 

O17 through O25). 
 
4) Print Trip, Varnish Trip, Damaged Can Blow-off (both drive and 

offside), and Pin Chain Blow-off solenoids (terminals O10 
through O16). 

 
5) No Can/No Print Sensors (both drive and offside, terminals I08, 

I09), and Spindle No.1 I.D. Sensor (terminal I09) using three 
conductor shielded cables. The shields of the sensor cables should 
be tied to earth ground at a terminal inside the existing control 
cabinet and left floating at the sensors.  

 
6) Set-Up Enable key switch (if desired) to allow entry to set-up 

variables through Keypad/Display. 
 
7) Resolver cable from resolver (or existing PLS) to 8-pin resolver 

input connector on the M4500 using a three pair, two conductor 
shielded cable. The shield of the resolver cable should be tied to 
the "SHLD" terminal of the M4500 resolver input connector. 
Make sure the resolver cable shield is left floating at the resolver. 
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________________________________________________________ 
2.4 MOUNTING THE HSL-QCSTA (OPTIONAL) 
 
The HSL-QCSTA is used to blow-off a can from a selected spindle 
(or blanket) from the pin chain for quality verification. If the optional 
HSL-QCSTA remote select-a-can PB station was purchased, mount it 
in the vicinity of the pin chain QC blow-off port in a convenient 
location for the operator. Wire the HSL-QCSTA to the HSL-CCSD1 
module referring to the electrical control schematic at the back of this 
manual. 
 
 
________________________________________________________ 
2.5 MOUNTING THE HSL-DSP REMOTE DISPLAY 
(OPTIONAL) 
 
The HSL-DSP is a remote 4 digit BCD display which displays either 
the current CPM or resolver position as selected by the operator. If the 
optional HSL-DSP remote RPM/Position display was purchased, 
make a cut-out in the operator's control console for the display where 
desired. 
 
Prior to mounting, remove the back cover of the display and set the 
dip switches as outlined on the electrical control schematic at the back 
of this manual. Mount the display and wire per the schematic at the 
back of this manual. A selector switch can also be mounted and wired 
as shown to select either CPM or position. 
 
 
________________________________________________________ 
2.6 MOUNTING THE RSV34-MS1 RESOLVER (IF 
REQUIRED) 
 
The HSL-CCSD1 is designed to interface to a resolver (not encoder) 
for machine timing. If the machine is not already equipped with a 
resolver, then the existing encoder will have to be removed and an 
RSV34-MS1 resolver will have to be mounted in it's place. If this is 
the case, refer to the RSV34-MS1 data sheet for details on mounting 
the resolver. 
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Note: The resolver must make one revolution for each spindle (24 
revolutions per spindle wheel revolution). Use the RSV-RSCBLE 
cable to connect the resolver to the HSL-CCSD1. Route the resolver 
cable in a separate conduit, away from all other high voltage and 
control wiring. Wire the cable directly to the 8-pin resolver connector 
on the HSL-CCSD1 (see section 2.3 – Wiring the HSL-CCSD1). 
 
 
________________________________________________________ 
2.7 MOUNTING THE SPINDLE #1 I.D. SENSOR (NOT 
PROVIDED) 
 
If the machine is not already provided with a spindle #1 I.D. sensor, 
then one will have to be mounted. This sensor is used to determine 
which spindle is the #1 spindle for both the QC select-a-can blow-off 
and the trips per spindle count. This must see a target once every 
revolution of the spindle wheel (once every 24 spindles). Any non-
discriminating 10-30VDC proximity sensor can be used and it can be 
mounted anywhere around the periphery of the spindle wheel. The 
target it looks at should be either a large steel bolt head or 1” by 1” 
square steel target mounted on the spindle wheel in the vicinity of 
spindle #1. 
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________________________________________________________ 
2.8 HSL-CCSD1 SOFTWARE INSTALLATION 
 
Follow the steps below to install either the Windows or DOS based 
setup programs and PLC application program on a PC used to support 
the HSL-CCSD1 control system. 
 
 
________________________________________________________ 
2.8.1 WINDOWS™ BASED SETUP PROGRAM 
INSTALLATION 
 
The CCSD setup program is compatible with Windows 
95/98/ME/2000/XP operating systems and is used to: 
1) Setup (tune) the user adjustable variables. 
2) Adjust the timing channel set-points. 
3) Download the application program to the M4500 module. 
4) Download (restore) or upload (save) the user setup variables from 

the M4500. 
5) View “Shift” and “Trips per Spindle” data.  
 
To install the set-up software, perform the following steps: 
1) Insert the HSM-CCSD CD into the drive 
2) From the Windows desktop, “Click” Start and then select run. 
3) From the “Run” dialog box, “Click” the Browse button.   
4) Select the drive with HSM-CCSD CD.  Select the “setup.exe” file 

and “Click” Open and then Ok. 
5) Follow the instructions that appear on the screen to complete the 

installation process.  The CCSD setup program can be executed 
from the “Systems” folder located under Programs from the Start 
menu. 
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________________________________________________________ 
2.8.2 DOS BASED SETUP PROGRAM INSTALLATION 
 
The HSL-CCSD1 set-up software is used to:   
1) Setup (tune) the user adjustable variables 
2) Adjust the timing channel set-points 
3) Download the application program to the M4500 module 
4) Download (restore) or upload (save) the user setup variables from 

the M4500 to disk 
5) View “Shift” and “Trips per Spindle” data. 
 
To install the DOS based set-up software perform the following steps: 
 
1) Create a directory off the root for each decorator. These will be 

used to store the “HSLCCSD1.EXE” setup program and set-up 
data for each decorator.  

 
Create these directories by typing the following at the DOS 
prompt: 

 
MD  \HSLDEC1<ENTER> (line 1 Decorator) 
MD  \HSLDEC2<ENTER> (line 2 Decorator) 
MD  \HSLDEC3<ENTER> (line 3 Decorator) 
etc. 

 
2) Install the “PROGRAMS” disk into the drive. For each 

“HSLDEC” directory you created, switch to that directory and 
install the “HSLCCSD1” set-up programs by typing the following 
at the DOS prompt (Line 1 decorator is shown): 

 
CD  \HSLDEC1<ENTER> 
A:INSTALL<ENTER> 

 
3) Add each decorator's set-up program to your computer's menu 

software by creating a selection for each decorator called “SET-
UP DECO LINE1” for the line #1 decorator, “SET-UP DECO 
LINE2” for the line #2 decorator, etc. The DOS commands 
executed for these selections should be (Line 1 decorator is 
shown): 

 
For the “SET-UP DECO LINE1” selection: 

CD  \HSLDEC1 
HSLCCSD1  HSLCCSD1 
CD  \ 
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4) To execute the respective decorator's set-up program, simply 
select the corresponding “SET-UP DECO LINE” selection from 
the menu software's menu. 

 
________________________________________________________ 
2.8.3 SYSdev PROGRAM DEVELOPMENT SOFTWARE 
INSTALLATION 
 
The SYSdev Program Development software is used to perform on-
line trouble-shooting and program modifications to the HSL-CCSD1. 
If SYSdev was purchased with the HSL-CCSD1 package and is not 
already installed on the your computer, install SYSdev onto the hard 
drive of your computer following the steps in outlined in the SYSdev 
Program Development manual. 
 
 
________________________________________________________ 
2.8.4 APPLICATION PROGRAM INSTALLATION 
 
The application program is a SYSdev based program, loaded into the 
M4500 module and performs the HSM-CCSD logic. The program is 
written in a combination of Ladder logic and High-level. If the user 
desires to make program changes or perform on-line monitoring of the 
program execution the files, which constitute the HSLCCSD1 
program, will have to be loaded onto the hard drive of the PC used to 
support the system. The SYSdev Program Development Software will 
also have to be loaded on the PC. To install this program perform the 
following: 
 
1) Install the “PROGRAMS” disk into the drive.  
 
2) For each of the “HSLDEC” directories (created in section 2.8.2), 

copy all the files from the disk to each of these subdirectories. 
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________________________________________________________ 
2.9 MODIFY EXISTING PLC PROGRAM 
 
Modify the existing control system PLC program to interface with the 
HSL-CCSD1 by incorporating the following into the existing PLC 
ladder logic: 
 
1) The HSL-CCSD1 now controls: 

• The damaged can blow-off 
• Print trip 
• Varnish trip 
• Pin chain blow-off 

 
If the existing host PLC was previously controlling these 
functions, this logic can optionally be removed from the existing 
host PLC if desired. In most cases this logic can be left in the 
program as connecting the respective solenoids to the HSL-
CCSD1 will effectively defeat the logic. 

 
2) Add the “Infeed Track Jam” and “Timing Signal Failure” alarms 

as inputs to the host PLC. These should stop the machine anytime 
either of these alarms are “on”. 

 
3) Add the “Print Trip Auto Mode” and “Print Trip Manual In” 

outputs into the PLC logic. When both are “off” the mandrel will 
be retracted. When the “Manual In” is “on”, the mandrel will be 
extended (print position). When the “Auto Mode” is “on”, the 
print is controlled by the no can/no print sensors. 

 
4) Add the “Varnish Auto Mode” and “Vanish Manual In” outputs 

into the PLC logic. When both are “off” the varnish unit will be 
retracted. When the “Manual In” is “on”, the varnish will be 
extended (varnish position). When the “Auto Mode” is “on”, the 
varnish unit is controlled by the no can/no print sensors. 

 
5) Add the “Damaged Can Auto Mode” and “Damaged Can Manual 

On” outputs into the PLC logic. When both are “off” the damaged 
can blow-off is disabled. When the “Manual On” is “on”, the 
damaged can blow-off is “on”. When the “Auto Mode” is “on”, 
the damaged can blow-off is controlled by the no can/no print 
sensors and infeed open. 
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6) Add the “Pin Chain Manual Blow-off” output to the PLC logic. 
This can be used as a manual blow-off. When “on”, the bad can 
pin chain (linear vacuum conveyor) blow-off is “on”. When “off”, 
the pin chain blow-off functions normally, blowing off detected 
bad cans, restart cans, etc. 

 
7) Add the “Can Feed Open” output to the PLC logic. This is used to 

indicate to the HSL-CCSD1 when the infeed is “open”. This is 
used for damaged can blow-off enable and for can count, blow-off 
counts, and trips per spindle counts enable. 

 
8) Add the “Main Drive On” output to the PLC logic. This should be 

“on” when the drive is enabled (running) and should be “off” 
when the drive is disabled (this includes auto stop conditions). 
This is true for jog modes as will. 

 
9) Add the “Alarm Reset” output. This signal should be “on” as long 

as the system reset push-button is depressed. 
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________________________________________________________ 
2.10 TUNING THE HSL-CCSD1 
 
The HSL-CCSD1 is shipped from the factory with the PLC program 
“HSLCCSD1” loaded in the PLC section and the channel set-point 
file “CCSD2TMG” loaded in the PLS section. These are the standard 
programs used to implement the standard HSL-CCSD1 decorator 
algorithms. In most cases, the following user variables and timing 
signals may have to be altered to tune the HSL-CCSD1 to the actual 
decorator it is controlling. 
 
Once the HSL-CCSD1 is installed and the control system is powered 
back up, perform the following to set-up and tune the HSL-CCSD1. 
The set-up is performed using the Display/Keypad or a PC running the  
set-up program. 
 
See the HSL-CCSD1 Keypad Quick Reference for exact key depress 
sequences for entering the following parameters. See section 3 of this 
manual for a description of the Keypad commands and menu displays 
of the HSL-CCSD1 Display/Keypad. See section 4 or 5 for a 
description of the menus, variables and how to use the set-up 
program. 
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________________________________________________________ 
2.10.1 DEFAULT SET-UP VARIABLES 
 
As shipped, the user variables for the HSL-CCSD1 are set the 
following defaults: 

 
Print Trip: 

Print Trip retract response time (msec)  : 020 
Print Trip extend response time (msec)  : 020 

 
Varnish Trip: 

Varnish Trip retract response time (msec)  : 020 
Varnish Trip extend response time (msec)  : 020 

 
Bad Can (pin chain) Blowoff: 

Blowoff solenoid “on” response time (msec)  : 015 
Blowoff solenoid “off” response time (msec)  : 020 
# of bad cans to blowoff for misload  : 001 
# of cans to blowoff from infeed open  : 005 
# of cans to blowoff from print at restart  : 000 
# of cans to blowoff from varnish at restart  : 033 
# of pins to pin chain blowoff port  : 028 

 
QC Can (select-a-can) Blowoff: 

Blowoff solenoid “on” response time (msec)  : 015 
Blowoff solenoid “off” response time (msec)  : 020 
QC can blowoff port shift offset  : 017 

 
Spindle Trip Offset  : 022 

 
The “CCSD2TMG” timing channel file, as shipped, contains the 
following default timing set-points: 
 

CHAN ON - OFF DESCRIPTION 
 
CH00: 120 - 160 Print Trip timing 
CH01: 275 - 315 Varnish Trip timing 
CH02: 180 - 000 Can/No Can clock 
CH03: 120 - 230 Damaged Can Blow-off (Low speed) 
CH04: 080 - 220 Damaged Can Blow-off (High speed) 
CH05: 155 - 195 Pin Chain Blow-off (bad can) timing 
CH06: 160 - 200 Select-A-Can (QC) Blow-off timing 
CH07: 000 - 040 Spare Timing 
CH10: 000 - 180 PLC Clock Timing 
CH11: ___ - ___ 
CH12: ___ - ___ 
CH13: ___ - ___ 
CH14: ___ - ___ 
CH15: ___ - ___ 
CH16: ___ - ___ 
CH17: ___ - ___ 
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________________________________________________________ 
2.10.2 SET MACHINE ZERO 
 
Position the machine with a spindle (any spindle - it does not have to 
be spindle #1) directly centered on the no can/no print sensors and set 
the offset per section 3.5.4 – Zero Machine (set Resolver Offset). 
 
 
________________________________________________________ 
2.10.3 VERIFY LOCATION OF NO CAN/NO PRINT 
SENSORS 
 
The machine is zeroed based on the location of the no can/no print 
sensors (not adjustable in the direction of can flow). With the machine 
zeroed as above, both no can/no print sensors should “see” a fully 
loaded can from about 320 degrees (first turn “on”) to about 40 
degrees (where sensors turn “off”). 
 
Verify that the sensors do not “see” an empty spindle (sensor too close 
to spindle) and that both do see a fully loaded can (sensor not too far 
out from spindle). 
 
The sensors should also be set to “see” the very edge of the open end 
of the can such that they will only detect fully loaded cans. If the 
sensors are set too far out towards the dome end, they may detect cans 
that are not fully loaded as being loaded which will result in a ring of 
inside litho at the top of the can that is next printed on that spindle. 
 
 
________________________________________________________ 
2.10.4 SET PIN CHAIN BLOW-OFF TIMING 
 
Using the Keypad/Display, set the bad can (pin chain) blowoff timing 
(CH05) such that the timing signal just turns “on” when the chain 
(linear vacuum conveyor) blowoff port is centered between cans on 
the chain (or conveyor). The signal should be 40 degrees wide. 
 
Note: Follow steps 2.10.5 through 2.10.7 to systematically set-up the 
pin chain blow-off, print trip, and varnish trip. These steps need to be 
followed sequentially as they depend on each other and the order they 
are executed. 
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________________________________________________________ 
2.10.5 SET # OF CANS TO PIN CHAIN BLOW-OFF PORT 
 
Using the Keypad/Display: 
1) Set the “# Of Pins To Pin Chain Blowoff Port”. Count the number 

of cans from where cans are transferred from the spindle wheel to 
the linear vacuum conveyor to the bad can pin chain blowoff port. 
Subtract 2 and enter this number (this is still just an 
approximation). 

 
2) Set the “# Of Bad Cans To Blowoff For Misload” equal to three. 

Run the machine at low speed with cans and induce misloads. 
Verify that for a miss-load three bad cans are blown off (mis-
loaded silver can blown off at damaged can blowoff port, printed 
cans ahead and behind mis-loaded can blown off at pin chain 
port). If not adjust “# Of Pins To Pin Chain Blowoff Port” 
accordingly until they are. 

 
Note: Silver cans may get through the line until this variable is 
set-up properly. Once this is set, you should be blowing off the 
can ahead of the misload (missing can), the misloaded can (which 
is missing) and the can behind the misload. 

 
3) Disable the damaged can blow-off by pulling the fuses for both 

the drive and offside damaged can blow-off solenoids.  
 
Note: For the next set-up steps, misloads can be induced by pressing 
the “blank” key on the Keypad/Display. This simulates a misloaded 
can by blanking out the no can/no print sensor input for one can space 
in the logic. This allows a fully loaded (non damaged) can to be blown 
off at the pin chain blow-off (without being printed). This is done so 
that the print and varnish trip can be verified by inspecting the can 
ahead, misloaded (silver) can, and the can behind. 
 
 

Proceed To Step 2.10.6 
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________________________________________________________ 
2.10.6 SET PRINT TRIP “RETRACT”/”EXTEND” RESPONSE 
TIMES 
 
Using the Keypad/Display, verify the print trip by running the 
machine at high speed, inducing mis-loads by pressing the “blank” 
key on the keypad and observing the cans blown off of the pin chain. 
With the damaged can blow-off disabled, the mis-loaded can will now 
be blown off at the pin chain blowoff and should be completely silver. 
 
The can ahead of the mis-load (can the print retracted after) should be 
blown off at the pin chain blow off port and should be fully printed. 
The can behind the mis-load (the can the print extended before) 
should be blown off at the pin chain blow off port and should be fully 
printed. 
 
If the 2nd can blown-off (which should be the misload and fully 
silver) has any print on it from the leading edge of the label image, the 
“Print Trip retract (out) response time” is too short and is not 
retracting soon enough. Increase the “Print Trip retract (out) response 
time” by 5 milliseconds and try again. Continue increasing this time 
until the 2nd can (misloaded can) is fully silver and the can ahead of it 
(the 1st can) is fully printed. If the 1st can is not fully printed, the 
“Print Trip retract (out) response time” is too long and is retracting 
too soon. Decrease the “Print Trip retract (out) response time” by 5 
milliseconds and try again. Continue decreasing this time until the 1st 
can is fully printed and the 2nd can (misload) is fully silver (no print 
on it). 
 
If the 3rd can (can following the misload) is not fully printed, the 
“Print Trip extend (in) response time” is too short and is not 
extending soon enough. Increase the “Print Trip extend (in) response 
time” by 5 milliseconds and try again. Continue increasing this time 
until the 3rd can is fully printed and the 2nd can (misload) is fully 
silver. If the 2nd (misload) can has any print on it from the trailing 
edge of the label image, the “Print Trip extend (in) response time” is 
too long and is extending too soon. Decrease the “Print Trip extend 
(in) response time” by 5 milliseconds and try again. Continue 
decreasing this time until the 2nd can (misload) is fully zero and the 
3rd can is fully printed. 
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________________________________________________________ 
2.10.7 SET VARNISH TRIP “RETRACT”/”EXTEND” 
RESPONSE TIME 
 
Set the varnish extend and retract response times in the same fashion 
as was done for the print. In general the mis-loaded can should have 
no varnish on it and the cans ahead and behind should be fully 
varnished. 
 
Once The Print And Varnish Are Set-Up: 
1) Set the “# Of Bad Cans To Blowoff For Misload” to “1” 
2) Reduce the “# Of Pins To Pin Chain Blowoff Port” by “1” such 

that only the misloaded (silver can) is blown-off 
3) Enable the damaged can blow-off by installing the fuses for both 

drive and offside damaged can blow-off solenoids. 
 
 
________________________________________________________ 
2.10.8 SET # OF CANS TO BLOW-OFF AT RESTART 
 
Using the Keypad/Display, set the following as desired  
• “# Of Cans To Blowoff From Infeed Open” 
• “# Of Cans To Blowoff From Print At Restart” 
• “# Of Cans To Blowoff From Varnish At Restart” 
 
 
________________________________________________________ 
2.10.9 SET QC BLOW-OFF SHIFT OFFSET 
 
Using the Keypad/Display, set the “QC can blowoff port shift offset” 
as follows:  
1) Dial in spindle #1 on the select-a-can thumbwheel switch 
2) With the machine running slowly, mark cans printed on spindle #1 

so they can be identified while they are on the chain.  
3) Press the select-a-can pushbutton and observe the can that was 

blown off with the location of a can printed on spindle #1. 
4) Add the number of cans difference between the can blown off and 

the can printed on spindle number one to the “QC can blowoff 
port shift offset”. 

 
Note: This variable must be a number between 1 and 24. Once set-
up, verify that a can from spindle #1 is blown off when 1 is dialed in 
on the thumbwheel and the select-a-can pushbutton is pressed. 
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________________________________________________________ 
2.10.10 SET SPINDLE TRIP SHIFT OFFSET 
 
Using the Keypad/Display, set the “Spindle trip shift offset” as 
follows:  
1) Initially set the “Spindle trip offset” to zero.  
2) Wrap a piece of tape around the drive side spindle #1 such that 

cans will not load on this spindle.  
3) Run the machine very slowly with the can gate open and verify 

that indeed cans do not load on spindle #1 and the print is tripped 
for that spindle. 

4) Observe the “Trips Per Spindle” data and determine which spindle 
is being incremented. The spindle number that should be 
incrementing is the drive side spindle #1. If it is not, subtract 1 
from the spindle number that is being incremented and enter this 
value as the spindle trip offset.  

 
Note: This variable must be a number between 0 and 23.  

 
5) Verify that the spindle #1 count is incremented every time the 

print trips for spindle #1. If it still increments another spindle 
number other than the drive side #1, continue adjusting the 
“spindle trip offset” until it does.  

6) Stop the machine and remove the tape from spindle #1. 
 

The Machine Is Now Set-Up And Ready To Run! 
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________________________________________________________ 
2.11 M4500/P4500/D4591 INSTALLATION 
 
The following is provided only as a reference. These steps are 
performed by the factory prior to shipping the HSL-CCSD1. These 
steps need only be performed in the event either the M4500 module, 
P4500 power supply, or D4591 display need to be replaced. Refer to 
the M4500 User's Manual for general details on installing the M4500, 
P4500, and D4591. 
 
 
________________________________________________________ 
2.11.1 M4500 MODULE INSTALLATION 
 
To install the M4500 module, perform the following: 
 
1) Remove the cover from the M4500 chassis (retained with three 

captive screws on the lower front of the cover and two captive 
screws on each side of the M4500 chassis). 

 
2) Install S4563 (SLOT0-0, furthest left slot): Set the slot address dip 

switches (SW1) on the S4563 to the following positions: 
 
 S4563: SW1 switch1 = “OFF” 
 SW1 switch2 = “OFF” 
 
3) Install S4568 (SLOT0-1, slot next to S4563): Set the slot address 

dip switches (SW1) on the S4568 to the following positions: 
 
 S4568: SW1 switch1 = “ON” 
 SW1 switch2 = “OFF” 
 
4) Install S4573 (SLOT0-2, slot next to S4568): Set the slot address 

dip switches (SW1) on the S4573 to the following positions: 
 
 S4573: SW1 switch1 = “OFF” 
 SW1 switch2 = “ON” 
 
5) Install the cover back over the M4500, making sure all the board 

connectors protrude the slots in the cover. Tighten the three 
captive screws on the lower front of the cover and the two captive 
screws on each side of the M4500 chassis. 
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6) Connect the display ribbon cable to the connector on the back of 
the M4500 (the connector on the cable is polarized and should 
mate with the M4500 only one way). 

 
7) Mount the M4500 chassis to the HSL-CCSD1 back panel using 

four 8-32 screws. 
 
8) With power to the P4500 “off”, install the P4500 power supply 

cable to the +5/C/+12/C/-12 connector on the M4500 (the 
connector on the cable is polarized and should mate with the 
connector on the M4500 only one way). 

 
9) Install the respective field wiring arms on all the I/O boards of the 

M4500 (I/O slots0 thru 2, resolver connector, and IN0/IN1 
connector). Make sure all field wiring connectors are fully mated 
in the M4500. 

 
 
________________________________________________________ 
2.11.2 P4500 POWER SUPPLY INSTALLATION 
 
To install the P4500, perform the following steps: 
 
1) Mount the P4500 to the HSL-CCSD1 in the mounting holes next 

to the M4500 (left side) using two 8-32 screws. 
 
2) With power to the P4500 “off”, install the P4500 power supply 

cable to the +5/C/+12/C/-12 connector on the M4500 (the 
connector on the cable is polarized and should mate with the 
connector on the M4500 only one way). 
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________________________________________________________ 
2.11.3 D4591 KEYPAD/DISPLAY INSTALLATION 
 
To install the D4591, perform the following steps: 
 
1) With the gasket installed on the mounting studs of the D4591, 

install the D4591 in the cut-out either in the HSL-CCSD1 
enclosure or the cut-out in the user's control cabinet. Secure the 
display to the enclosure using 7ea. 8-32 nuts and external lock 
washers. 

 
2) Connect the display ribbon cable to the connector on the lower 

back of the display (the connector on the cable is polarized and 
should mate with connector on the M4500 only one way). 

 
 
________________________________________________________ 
2.11.3 DOWNLOAD APPLICATION PROGRAM AND SET-UP 
DATA TO M4500 
 
Once the M4500, P4500 and D4591 are installed, perform the 
following to download the application program to the M4500 as well 
as download the previously saved set-up data and timing channel set-
points: 
 
1) Power up the M4500 and the PC used to interface with the HSL-

CCSD1 and connect an RS-232 cable from the COM port on the 
computer to the “PROG” port on the M4500. 

 
2) Initiate the respective setup program (CCSD for Windows 

systems, HSLCCSD1.exe for DOS systems). 
 
3) Download the application program to the M4500. See section 

4.2.3 for Windows systems, see section 5.7 for DOS. 
 
4) Download the PLS timing set-points to the M4500. See section 

4.2.3 for Windows systems, section 5.3 for DOS.  
 
5) Download the previously saved set-up data to the M4500. See 

section 4.2.3 for Windows systems, section 5.8 for DOS. 
 
7) The M4500 is now ready to run, loaded with the application 

program, timing set-points, and set-up data. Double check the 
machine zero position and re-zero the resolver if necessary. 
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The Keypad/Display of the HSL-CCSD1 contains 24 keys consisting 
of data display commands, set-up commands, and a numeric keypad. 
The display of the HSL-CCSD1 is 2 line by 40 character back-lit LCD 
display which displays the selected data and set-up menus. The 
keypad/display can be used to view data, activate the select-a-can QC 
blow-off and to adjust the timing and all set-up parameters (passcode 
or key switch protected). 
 
 

 
 
The Keypad/Display allows the following to be viewed or adjusted: 
 

1) Set Print/Varnish Response Times 
2) Set Pin Chain/QC Blow-off Parameters 
3) Set Machine Timing 
4) Set Machine Zero 
5) View the Number of Trips per Spindle 
6) View the Current Shift Data 
7) View the Last Shift Data 
8) Activate the select-a-can QC blow-off 

 
The definitions of the keypad commands and menus are described in 
the following sections.  
 
Note: For virtually all the menus, the “NEXT” and “PREV” keys can 
be used to advance to the next item of the menu or retard to the 
previous item on the menu. 
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________________________________________________________ 
3.1 DEFAULT SCREEN 
 
The default screen (displayed when no other commands are active) 
contains the following data: 
 

MACHINE SPEED (CPM):xxxx 
GOOD CANS:xxxxxxx       BLOW-OFFS:xxxxxx 

 
Where the “Machine Speed” is the current speed of the decorator, the 
“Good Cans” field is the total number of good cans printed so far into 
the current shift, and the “Blow-offs” field is the total number of cans 
blown-off the machine (scrap) so far into the current shift. This 
display effectively replaces a speed meter, and two can counters. This 
screen is always returned to when no commands are active. 
 
 
________________________________________________________ 
3.2 “TRIPS PER SPINDLE” KEY 
 
The Number of trips per spindle menu is provided to aid in the 
trouble-shooting of a loading problem with a spindle or spindles. The 
total number of trips for each spindle since the last reset or end of 
shift is displayed. The operator can reset these counts at any time to 
aid in the trouble-shooting process. The data can be viewed simply by 
pressing this key. The display shows a series of screens each with four 
spindles from 1 through 24 for the “Drive Side” as shown below: 
 

-- DRIVESIDE MISLOADS PER SPINDLE -- 
1:xxxx       2:xxxx        3:xxxx        4:xxxx 

 
Where the numbers 1 through 4 are the first 4 spindles of the drive 
side and the “xxxx” would be the actual counts for the respective 
spindles. Screens for spindles 5 thru 8, 9 thru 12, etc. are shown in 
this fashion each for a time delay of 10 seconds. In addition, the user 
can advance to the next screen or retard to the previous screen by 
pressing the “NEXT” or “PREV” key respectively. 
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Once all 24 spindles for the “Drive Side” are displayed, a series of 
screens each with four spindles from 1 through 24 for the “Offside” as 
shown below: 
 

-- OFFSIDE MISLOADS PER SPINDLE -- 
1:xxxx       2:xxxx        3:xxxx        4:xxxx 

 
As with the “Drive Side”, all 24 spindles of the offside are shown this 
way.  
 
Note: When a spindle misloads, it is only counted on the spindle of 
the side that it misloaded (e.g. if a can misloads on the drive side 
spindle #3, the count for the “Drive Side Spindle #3” will be 
incremented while the count for the “Offside Spindle #3” is not 
incremented). 
 
The final screen of this menu, prompts the user to reset the counts by 
pressing “0”. This provides the opportunity to reset the counts for 
trouble-shooting. If the counts are not to be reset, press the “ESC” 
key. The default screen will then be displayed. 
 
Note: The “ESC” key can also be used at any time to abort the trips 
per spindle data display and return to the default screen. 
 
 



SECTION 3 
USING THE KEYPAD/DISPLAY 

 
HSL-CCSD1 User’s Manual SYSTEMS Electronics Group 

 
- 32 - 

________________________________________________________ 
3.3 “CURRENT SHIFT” KEY 
 
The “Current Shift” key is used to view the current shift data. This is 
the totals so far into the shift. The data is transferred to the “Last 
shift” data when the end of shift input transfers from a “0” to a “1”. 
This can be at the end of either an 8 or 12 hour shift or alternatively 
could be done at label changes such the data collected would be for 
label runs rather than complete shifts. This data cannot be reset by the 
operator, only at the end of shift input transition.  
 
Note: The Current shift “Good Cans” and “Blow-offs” is displayed as 
part of the default screen. 
 
The Current Shift data is defined as follows: 
 
Good Cans: This is the total number of good cans printed so far into 
the shift. This is essentially a can counter. 
 
Blow-offs: This is the total number of cans blown-off the machine. 
This includes all types of blow-offs:  
• Cans blown off due to a  mis-loaded 
• Infeed open blow-offs 
• Restart blow-offs 
• Manual blow-offs 
• Select-A-Can QC blow-offs 
 
Bad Cans: This is the total number of cans blown off due to 
misloads. When a can misloads on one side of the machine, both cans 
are blown off. Thus this count is incremented twice for every misload. 
 
Restart Blow-offs: This is the total number of cans blown off at 
restart from: 
• Infeed open 
• The print station 
• The varnish station 
 
Manual Blow-offs: This is the total number of cans blown-off by 
the operator using the Manual Blow-off PB or selector switch. 
 
QC Blow-offs: This is the total number of cans blown-off by the the 
Select-A-Can QC station or QC Blow-off key on the Keypad/Display 
for quality verification. 
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DrvSide Trips: This is the total number of misloads on the drive 
side. This is only incremented once for every misload on a drive side 
spindle. 
 
OffSide Trips: This is the total number of misloads on the offside. 
This is only incremented once for every misload on an offside spindle. 
 
Driveside Misloads per Spindle (1:-24:): This is the total trips 
(mis-loads) for each spindle on the drive side. A disproportionately 
high count for a particular spindle indicates a loading problem for that 
spindle. 
 
Offside Misloads per Spindle (1:-24:): This is the total trips 
(mis-loads) for each spindle on the offside. A disproportionately high 
count for a particular spindle indicates a loading problem for that 
spindle. 
 
Note: When a misload occurs, it is only counted on the spindle of the 
side that it occurs on. 
 
 
________________________________________________________ 
3.4 “LAST SHIFT” KEY 
 
The “Last Shift” data is identical to the current shift data except it is 
for the previous 8 or 12 hour shift or previous label run, however the 
shift collection is set-up. This allows data collection and diagnostics 
to take place automatically over a two-shift period. Refer to section 
3.3 – “Current Shift” Key, for definitions of the data fields in the 
“Last Shift” data menu. 
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________________________________________________________ 
3.5 “SET-UP” KEY 
 
This selection is used to invoke the primary set-up menu. This 
consists of the following four selections: 
 

1: SET PRINT/VARNISH RESPONSE TIMES 
2: SET PIN CHAIN/QC BLOW-OFF PARAMETERS 
3: SET MACHINE TIMING (SET-POINTS, ETC.) 
4: ZERO MACHINE (SET RESOLVER OFFSET) 

 
When selected, each of the above selections brings up a sub-menu 
with the corresponding set-up parameters. To select the respective set-
up sub-menu, press the corresponding numeric key (1 thru 4). The 
following sections describe these sub-menus and the definitions of the 
setup variables.  
 
Note: The primary set-up menu is passcode protected. When the set-
up key is first depressed, an “ENTER PASSCODE:” prompt is 
displayed. The correct 5-digit passcode must be entered to gain access 
to the setup menus. If the passcode entered is correct, the primary set-
up menu is displayed and any of the parameters accessed by this menu 
may be changed. If the passcode entered is incorrect, the message 
“INCORRECT PASSCODE” will be displayed. At this time the 
passcode may be entered again or the <ESC> key can be pressed to 
return back to the main menu. 
 
As the passcode is entered, the digits are not displayed. Instead “*” 
characters are displayed as each digit is entered. In addition, the 
“ENTER PASSCODE” prompt is only displayed for a maximum of 
60 seconds. The correct passcode must be entered within this 60 
second period otherwise the set-up mode is aborted and the main 
menu is displayed. 
 
Refer to section 3.7 (Set Keypad/Display “Set-up” passcode) for 
details on setting the passcode. 
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For user's that would prefer to use a keyed switch to prevent 
unauthorized access instead of a passcode, the “Set-Up Enable” input 
can be used. When this input is “on”, the passcode prompt is bypassed 
and access to the primary set-up menu is provided immediately. If the 
“Set-Up Enable” input is “off”, then the normal passcode prompt is 
displayed. A keyed switch can then be wired to the “Set-Up Enable” 
input such that when the switch is in the enable position, the input is 
“on”. 
 
Note: To change the currently displayed parameter, enter the new 
value on the numeric keypad and press <ENTER>. The value will be 
entered and the next parameter will be displayed automatically. When 
the last parameter is entered, the primary set-up menu is again 
displayed. Pressing <ESC> at anytime will also exit you back to the 
primary set-up menu. 
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________________________________________________________ 
3.5.1 SET PRINT/VARNISH RESPONSE TIMES 
 
This menu is activated when the “1” key (SET PRINT/VARNISH 
RESPONSE TIMES) is pressed while the primary set-up menu is 
active. The following four set-up parameters may then be adjusted or 
viewed: 
 
Print Trip Retract (out) Response Time (msec): This is the 
time used as the retract response time of the print trip (time from 
solenoid actuation to first break with blanket) in milliseconds. The 
HSL-CCSD1 will activate the retract solenoid this amount of time 
ahead of the Print trip timing (CH00) (usually set at 20 milliseconds). 
 
Print Trip Extend (in) Response Time (msec): This is the time 
used as the extend response time of the print trip (time from solenoid 
actuation to first contact with blanket) in milliseconds. The HSL-
CCSD1 will activate the extend solenoid this amount of time ahead of 
the Print trip timing (CH00) (usually set at 20 milliseconds). 
 
Varnish Trip Retract (out) Response Time (msec): This is the 
time used as the retract response time of the varnish trip (time from 
solenoid actuation to first break with varnish wheel) in milliseconds. 
The HSL-CCSD1 will activate the extend solenoid this amount of 
time ahead of the Varnish unit trip timing (CH01) (usually set at 20 
milliseconds). 
 
Varnish Trip Extend (in) Response Time (msec): This is the 
time used as the extend response time of the varnish trip (time from 
solenoid actuation to first contact with varnish wheel) in milliseconds. 
The HSL-CCSD1 will activate the extend solenoid this amount of 
time ahead of the Varnish unit trip timing (CH01) (usually set at 20 
milliseconds). 
 
Note: All response times entered must be in the range of 5 to 65 
milliseconds. 
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________________________________________________________ 
3.5.2 SET PIN CHAIN/QC BLOW-OFF PARAMETERS 
 
This menu is activated when the “2” key (SET PIN CHAIN/QC 
BLOW-OFF PARAMETERS) is pressed while the primary set-up 
menu is active. The following blow-off set-up parameters may then be 
adjusted or viewed: 
 
# Cans to Blow-off at Infeed Open: This is the number of cans 
that will be blown off when the infeed is first opened. Valid range: 0 
to 99. 
 
# Cans to Blow-off from Print at Restart: This is the number of 
cans that will be blown off from the print station when the machine is 
restarted. Valid range: 0 to 99. 
 
# Cans to Blow-off from Varnish at Restart: This is the 
number of cans that will be blown off from the varnish station when 
the machine is restarted. Valid range: 0 to 99. 
 
# Cans to Blow-off for each Misload: This is the number of cans 
blown off at the pin chain port when one mis-loaded can is detected 
(typically set at 1 can). 
 
# Pins to Pin Chain Blow-off Port: This is the number of pins 
from the spindle wheel to disk transfer location to the first can blown 
off at the Pin Chain blow-off port minus two. This can be a number 
from 0 to 999. 
 
Pin Chain (bad can) Solenoid “on” Response Time (msec): 
This is the time used as the “on” response time of the pin chain blow-
off port (time from “on” solenoid actuation to first air out port) in 
milliseconds. The HSL-CCSD1 will activate the solenoid this amount 
of time ahead of the Pin Chain blow-off timing (CH05) (usually set at 
15 to 20 milliseconds). Valid range: 5 to 50 msec. 
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Pin Chain (bad can) Solenoid “off” Response Time (msec): 
This is the time used as the “off” response time of the pin chain blow-
off port (time from “off” solenoid actuation to air stopping at port) in 
milliseconds. The HSL-CCSD1 will activate the solenoid this amount 
of time ahead of the Pin Chain blow-off timing (CH05) (usually set at 
15 to 20 milliseconds for double acting solenoids and set at 25 to 30 
milliseconds for single acting solenoids). Valid range: 5 to 50 msec. 
 
QC Blow-off Solenoid “on” Response Time (msec): This is 
the time used as the “on” response time of the QC blow-off port (time 
from “on” solenoid actuation to first air out port) in milliseconds. The 
HSL-CCSD1 will activate the solenoid this amount of time ahead of 
the QC blow-off timing (CH06) (usually set at 15 to 20 milliseconds). 
Valid range: 5 to 50 msec. 
 
QC Blow-off Solenoid “off” Response Time (msec): This is 
the time used as the “off” response time of the QC blow-off port (time 
from “off” solenoid actuation to air stopping at port) in milliseconds. 
The HSL-CCSD1 will activate the solenoid this amount of time ahead 
of the QC blow-off timing (CH06) (usually set at 15 to 20 
milliseconds for double acting solenoids and set at 25 to 30 
milliseconds for single acting solenoids). Valid range: 5 to 50 msec. 
 
QC Blow-off Shift Offset: This is the number of spindles 
difference from detection of the spindle #1 flag to the QC blow-off 
port. This is a number between 1 and 24 and is empirically set by 
selecting spindle #1 for blow-off and adjusting this value until the can 
from spindle #1 is the can that is blown off. 
 
Spindle Trip Shift Offset: This is the number of spindle difference 
from the detection of the spindle #1 flag to the No Can/No Print 
sensors. This is a number between 0 and 23 and is empirically set 
such that a mis-loaded can on spindle #1 increments the spindle #1 
count in the “Trips per spindle” menu (see section 2.10.10 – Set 
Spindle Trip Offset). 
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________________________________________________________ 
3.5.3 SET MACHINE TIMING (SET-POINTS, ETC.) 
 
This selection brings up the timing set-point menu which displays the 
following fields: 
 

CHuu  SETPOINT:xxx   []  “channel name” 
RPM:yyyy    POS:zzz     OFFSET:wwww  SCALE:360 

 
Each field is defined as follows: 
 
Field Definition 
Chuu Currently selected channel (CH00 thru CH17) 

where “uu” is the octal channel number. 
 
SETPOINT:xxx Channel “on” or “off” set-point where “xxx” is 

the set-point position 
 
[] State of channel set-point (blank = “off”, solid 

block character = “on”) 
 
“channel name” selected channel name: (CH00) PRINT TRIP, 

(CH01) VARNISH UNIT TRIP, etc. 
 
RPM:yyyy Current machine speed where “yyyy” is in CPM. 
 
POS:zzz Current resolver position where “zzz” is in 

degrees. 
 
OFFSET:wwww Resolver offset where “wwww” is the offset in 

degrees. 
 
SCALE:360 Resolver SCALE FACTOR (360 degrees per 

revolution). 
 
 
In addition to displaying the timing set-point menu, the following keys 
are also enabled: “ENTER SET-POINT”, “CLEAR CHANNEL”, 
“SELECT CHANNEL”, and “SEARCH CHANNEL”. 
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The “ENTER SET-POINT” key is used to enter a new set-point (both 
“on” and “off” set-points) in the selected channel. The “CLEAR 
CHANNEL” key is used to clear all set-points from the selected 
channel. The “SELECT CHANNEL” key is used to select a new 
channel for programming. The “SEARCH CHANNEL” is used to 
view both the “on” and “off” set-points in the selected channel. 
 
Searching Channel: To view the set-points in a channel simply 
press the “SEARCH CHANNEL” key. The next “off” to “on” or “on” 
to “off” position is shown in the “SETPOINT” field. If the transition 
was “off” to “on”, the state character [] will be a solid block. If the 
transition was “on” to “off”, the state character [] will be blank. 
 
Entering or Adjusting Set-point: To set or adjust a timing 
channel, perform the following: 
 
1) Select the channel to be adjusted by pressing the “SELECT 

CHANNEL” key, entering the channel number (00 to 17) and 
pressing <ENTER>. In addition, the “NEXT” and “PREV” keys 
can be used to advance to the next channel or retard to the 
previous channel. 

 
2) Press “CLEAR CHANNEL” to clear the existing set-point out. 

Note: Entering a new set-point does not automatically clear the 
old set-point out. If the two set-points are not in the same place, 
the channel will simply have two set-points in it if the old one is 
not cleared out first. Therefore always clear the channel before 
entering a new set-point. A set-point may, however, be “extended” 
by programming another set-point onto an existing set-point using 
either the existing “on” or “off” set-point as the starting position 
for the new set-point. This will result in one larger set-point. 

 
3) Press “ENTER SET-POINT” to enter the new set-point. The 

display will then prompt ““ON” SETPOINT:”. Enter the position 
(in degrees) where the set-point should go “on” and press 
<ENTER>. The display will now prompt ““OFF” SETPOINT:”. 
Enter the position (in degrees) where the set-point should go “off” 
and press <ENTER>. The channel will now be programmed with 
a set-point that goes “on” at the “on” position entered and “off” at 
the “off” position entered. 

 
4) Exit back to the primary set-up menu by pressing <ESC>. Exit 

back to the default screen by pressing <ESC> again. 
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________________________________________________________ 
3.5.4 ZERO MACHINE (SET RESOLVER OFFSET) 
 
This selection is used to auto zero the resolver. To set the machine 
zero (resolver offset) perform the following: 
 
1) Select “3: SET MACHINE TIMING” and observe the “POS:” 

field. Verify that as the machine is rotated forward (either jogged 
or barred) that the position increases linearly from 0 through 359. 
If not, swap the S1 and S3 leads of the resolver at the HSL-
CCSD1 resolver connector. Then verify that the position then 
indeed does increase with forward movement. Press <ESC> to 
exit back to the primary set-up menu. 

 
2) Position the machine at machine zero (spindle centered on No 

Can/No Print Sensors). 
 
3) Auto zero the resolver by selecting “4: ZERO MACHINE” from 

the primary set-up menu. Enter “0” to zero the resolver. The 
timing set-up menu will be displayed, now showing the “POS:” at 
zero. 

 
4) The HSL-CCSD1 will calculate the actual offset value required to 

make this the 000 position and will display this number in the 
offset field. 

 
5) Exit back to the primary set-up menu by pressing <ESC>. Exit 

back to the default screen by pressing <ESC> again. 
 
 
________________________________________________________ 
3.6 “QC BLOW-OFF” KEY 
 
This key is used to blow-off a can from a selected spindle at the Pin 
Chain QC Blow-off port. To blow-off a can, press the “QC BLOW-
OFF” key. The display will then prompt “Enter Spindle to Blow Can 
off”. Enter the desired spindle number (1-24) and press enter. A can 
from that spindle will be blown off at the Pin Chain QC blow-off port. 
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________________________________________________________ 
3.7 SET KEYPAD/DISPLAY “SET-UP” PASSCODE 
 
The “Set Passcode” input to the HSL-CCSD1 is used to set or view 
the passcode of the set-up menu. Normally this input should be “off”. 
To the passcode, jumper this input to +24VDC and press the “Set-Up” 
key. The “ENTER PASSCODE” prompt, along with the current 5-
digit passcode, will be displayed. This allows the passcode to be 
viewed if necessary. 
 
To change the passcode, enter any number between 0 and 64999 and 
press <ENTER>. 
 
Note: If passcode protection will not be used, set the passcode to “0”. 
Then when the passcode is prompted for after the “Set-up” key is 
pressed, simply press <ENTER> to proceed to the set-up menu. If the 
passcode protection will be used, set the passcode to a number from 1 
to 64999. Then when the “Set-up” key is pressed, the actual valid 
passcode number will have to be entered to gain access to the set-up 
menu. 
 
Once the passcode is set, turn the “Set Passcode” input back “off” and 
now the set-up menu will be passcode protected with the number you 
have entered as the passcode. 
 
 
 



SECTION 4 
CCSD WINDOWS BASED 

SETUP PROGRAM REFERENCE 

 
HSL-CCSD1 User’s Manual SYSTEMS Electronics Group 

 
- 43 - 

The Windows based set-up program is menu driven, allowing the user 
to easily view data, alter set-up variables or set machine timing 
(machine offset, timing signal locations, etc.), using a PC running the 
Windows (95/98/ME/2000/XP/NT) operating system. The set-up 
variables are used to configure and tune the M4500 to match the 
configuration and performance of the specific decorator (see Tuning 
the HSL-CCSD1, section 2.10). 
 
Note:  The set-up program is an on-line communications program 
used to interface with the M4500 module.  The data displayed and set 
in the windows is communicated directly to the module, while in the 
“Online” edit mode. Therefore, prior to going online with the 
processor, make sure an RS-232 cable is connected from the COM 
port on the computer to the “PROG” port on the M4500.  The 
variables displayed while in the “Online” edit mode are read directly 
from the processor.  Data is saved to a “Set-up Data” file (*.sdt) 
whenever changes are made to a parameter or if the data is uploaded 
from the processor. 
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________________________________________________________ 
4.1 GENERAL DESCRIPTION 
 
Title Bar:  At the top of the window is the “Title Bar”.  The title bar 
is used to display the name of the working “Set-up Data” file, as well 
as, the name of the active “Window”.  The title bar is dark if the 
window is active and grayed if another window is active.  The color 
depends on the settings of the Display Properties of the Control Panel. 
 
Status Bar:  At the bottom of the window is the “Status Bar”.  The 
status bar is used to display system messages, online or offline mode, 
as well as, the current time and date as set by the operating system.  
The system messages panel displays general information about 
operation of the system.  The Online/Offline mode panel displays the 
status of the current set-up program mode of operation.  The mode of 
operation can be changed by simply double clicking the online/offline 
mode panel. 
 
Hot Keys:  Hot keys are activated by holding down the “ALT” key 
and simultaneously pressing the underlined letter of the desired 
function.  Almost every function can be activated by either pressing a 
series of hot keys or using the “TAB” key to move between fields. 
 
Online/Offline Modes:  The set-up program allows the user to 
make changes while “Online” with the processor.  The “Offline” 
mode is used to preset parameters prior to download.  All functions 
are available to the user while “Online”, however, specific “Online” 
functions are disabled in the “Offline” edit mode. 
 
Note:  Offline changes can only be made by enabling “Offline 
Editing”, accessed under the “Edit” menu. 
 
Getting Help:  The entire contents of the user’s manual is contained 
within the help file.  Pressing Ctrl+H will display the help file 
window.  Pressing the F1 key will display the contents file.  Hot spots 
allow jumps to other topics to display additional information as 
desired.  Selecting “About CCSD” from the Help menu will display a 
dialog box listing information about the current revision of the setup 
program and how to obtain technical support. 
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________________________________________________________ 
4.2 THE FILE MENU 
 
The “File” menu allows the user to perform the following functions: 
 
• Create a “New” set-up “Data File”. 
• Open an existing “Data File”. 
• Save any changes made to the current “Data File” to disk. 
• Upload (save) Data from the Processor. 
• Download a SYSdev (.sdv) program to the processor 
• Download (restore) Data from the current set-up “Data File” to the 

processor 
• Print a Report of the current set-up parameters. 
• Exit the set-up program 
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________________________________________________________ 
4.2.1 THE SET-UP DATA FILE 
 
The set-up “Data File” (.sdt) is a binary access file, designed for fast 
file I/O operation.  When the set-up program is first invoked, the 
default set-up parameters are loaded into memory.  If changes are 
made to any of the set-up parameters (either online or offline), as well 
as shift data, the user will be flagged to “Save Changes” upon exit of 
the program. 
 
Note:  Any windows based “Set-up” program can open a set-up 
“Data File”, however the data tables will not be properly aligned.  The 
user will be alerted to the problem if a set-up data file has been 
created by either a different set-up program or a different revision of 
the software. 
 
The set-up “Data File” is similar to that of a word processing file.  
When the program first starts, the default settings are loaded and the 
user is able to make any changes as desired.  The set-up program is 
unaware of the settings and parameters that exist within the M4500.  
Therefore, to normalize the set-up program with the processor, the 
user should define or open an existing file, then upload “All” 
variables from the processor.  This allows the user to either create a 
backup of the data or maintain an existing file.  The user can even 
open a data file for another decorator, save the file to a new name, 
make the necessary changes and simply download the new parameters 
to another processor. 
 
The following functions can be accessed any time, from any set-up or 
display windows. 
 
New:  To create a “New” data file, select “New” from the “File” 
menu or press “Ctrl + N”.  This creates a completely new file, loaded 
with the default variables and the word “[unnamed]” is displayed in 
the title bar.  If any changes were made to the existing file, the user is 
prompted to save changes to the existing file. 
 
Open:  To “Open” and existing data file, select “Open” from the 
“File” menu or press “Ctrl + O”.  This displays a dialog box allowing 
the user to select an existing data file to open. The name of the file 
will be displayed in the title bar.  If any changes were made to the 
existing file, the user will be prompted to save any changes before 
terminating the program. 
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Save:  To “Save” data file to disk, select “Save” from the “File” 
menu or press “Ctrl + S”.  If this is a “New” file, a dialog box 
allowing the user to select a folder and enter a name for the file will 
be displayed.  The user will be notified if the file already exists and 
the extension “.sdt” will automatically be added to the file name.   
 
Save As:  To save the data file to a new name, select “Save As” 
from the “File” menu..  This displays a dialog box allowing the user to 
select a folder and enter in a new name for the file.  The user will be 
notified if the file exists and the extension “.sdt” will automatically be 
added to the file name. 
 
Export Shift Data…:  This function allows the user to export the 
shift data to a “Tab Delimited” text file.  This allows the user to easily 
use the shift data to produce production reports. 
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________________________________________________________ 
4.2.2 UPLOAD (SAVE) DATA 
 
The “Set-up” program allows the user to upload blow-off parameters, 
timing channel set-points and shift data from the M4500 into a set-up 
“Data File”.  This function is accessed from the “File” menu and the 
user is given the choice of the following options: 
 

 
 
Set-up Parameters:  This option only uploads the “Set-up” data 
from the M4500.  This includes the print trip and varnish unit 
response times, as well as blow-off parameters and solenoid response 
times. 
 
Timing Channels:  This option only uploads the “Machine Timing” 
channel set-points, as well as, the PLS configuration and scale factor. 
 
Shift Data:  This option only uploads the “Shift Data” from the 
M4500.  This includes the “Trips per Spindle” data, the “Current 
Shift” and the “Last Shift” data. 
 
All:  This option allows the user to completely upload “All” of the 
set-up parameters, timing channel set-points and shift data from the 
M4500. 
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________________________________________________________ 
4.2.3 DOWNLOAD PROGRAM 
 
The “Set-up” program allows the user to “Download” any SYSdev 
program file to the M4500. 
 

 
 
Note:  To “Download” a SYSdev program to the processor, the 
program must be “Online”.  If “Online” mode cannot be achieved, 
program download will not be executed.  If the program is currently 
“Offline”, the user will be prompted to first go “Online”. 
 
Once selected, and the set-up program “Online” with the processor, a 
dialog box will be displayed, allowing the user to select the SYSdev 
file to download. 
 
Note:  Only the files with the “.sdv” file extension will be displayed.  
It is important to keep in mind that only a valid M4500 PLC SYSdev 
file can be downloaded through the set-up program.  Care should be 
taken when selecting a program to download. 
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Once selected, a message box is displayed informing the user of the 
current program, revision and checksum of the program loaded in the 
processor, as well as, that of the selected program.  The user must 
confirm their selection by clicking the “Yes” command button.  After 
the user confirms their choice, program download is initiated and the 
current program download address is displayed.  When program 
download is complete, the user is prompted to acknowledge.  Control 
is passed back to the main program and the set-up program remains in 
an “Online” edit mode. 
 
 
________________________________________________________ 
4.2.3 DOWNLOAD (RESTORE) DATA 
 
The set-up program allows the user to download  “Set-up” parameters, 
timing channel set-points and shift data to the M4500 from the set-up 
“Data File”.  This function is accessed from the “File” menu and the 
user is given the choice of the following options: 
 

 
 
Set-up Parameters:  This option downloads the “Set-up” data to 
the M4500.  This includes print trip and varnish unit response times 
and blow-off parameters. 
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Timing Channels:  This option downloads the “Machine Timing” 
channel set-points, as well as the PLS configuration and scale factor to 
the M4500 PLS. 
 
Shift Data:  This option downloads the “Shift Data” to the M4500.  
This includes the “Trips per Spindle” data, the “Current Shift” and the 
“Last Shift” data. 
 
All:  This option allows the user to completely download “All” of the 
set-up parameters, timing channel set-points and shift data to the 
M4500. 
 
Note:  Only the values contained within the current data file are used.  
If the validity of the current data file is questionable, review the data 
in an “Offline” mode prior to download. 
 
 
________________________________________________________ 
4.2.4 PRINT REPORT 
 
The “Set-up” program allows the user to generate a “Report” printout 
of all the set-up parameters, timing channel set-points and shift data.  
This function is accessed from the “File” menu. 
 
At the top of each page, the report displays the name of the set-up file 
being printed.  At the bottom of each page is the date and time the 
document was printed, as well as, the page number. 
 
To printout a report of the settings contained in the set-up “Data File”, 
perform the following: 
 
1) From the “File” menu, select “Print Report” or press “Ctrl + P”.  

This displays the “Print Setup” dialog box, allowing the user to 
select a printer, as well as, the paper size and orientation.  Once 
the user selects “OK”, the report is generated and sent to the 
specified printer device.  This function makes use of the windows 
print manager, which allows the user to continue with their work 
while the document is being printed. 
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________________________________________________________ 
4.3 THE EDIT MENU 
 
The “Edit” menu allows the user to perform the following functions: 
 

 
 
 
________________________________________________________ 
4.3.1 ENABLE OFFLINE EDITING 
 
This function allows the user to perform “Offline” editing on the 
currently loaded set-up data file.  This allows the user the ability to 
make any necessary changes to the set-up parameters while not online 
with the processor.   
 
If offline editing is not enabled, the user is only able to view the set-
up parameters and shift data.  When the program is first invoked, the 
default setting is offline editing disabled.  The user will need to 
specifically select “Enable Offline Editing” from the edit menu (or 
press function key F2) to enable/disable this feature. 
 
 



SECTION 4 
CCSD WINDOWS BASED 

SETUP PROGRAM REFERENCE 

 
HSL-CCSD1 User’s Manual SYSTEMS Electronics Group 

 
- 53 - 

________________________________________________________ 
4.3.2 SETUP COMM PORT 
 
This function allows the user to specify the serial communications 
port and rate to talk to the M4500.  The programming port of the 
M4500 is set to 9600 baud.   
 

 
 
Once selected, a dialog box requesting the user to select a “Comm 
Port” and “Baud Rate” will be displayed.  The default setting is 
COM1 at 9600 baud.  The option to select the 19200 baud rate is to 
allow the user to communicate with the processor via the S4516 serial 
communications board. 
 
In most cases, the user will only need to specify the communications 
port and leave the baud rate at 9600.  If communication problems 
occur, make sure there is a secure connection from the PC to the PLC.  
Then check the Comm port.  In most cases the user will only need to 
select a new Comm port.  If communication problems persist, there 
may be another program causing a conflict with the port.  Check the 
port configuration from the “Settings” folder. 
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________________________________________________________ 
4.3.3 EDIT SETUP PASSCODE 
 
The edit “Set-up Passcode” is an “Online” function only.  This allows 
the user the ability to directly change the value of the “Set-up 
Passcode”. 
 
Once selected, an input box is displayed, allowing the user to view the 
current “Passcode” setting and to change the value if necessary.  If the 
passcode is set to zero, passcode entry is disabled.  The operator can 
press the Set-up key on the Keypad/Display and simply press the 
<ENTER> key to gain access to the set-up parameters without having 
to enter a zero.  
 
If the value of the passcode is set somewhere between 1 and 65,000, 
“Passcode Entry” is enabled.  This requires the operator to enter in the 
“Correct” passcode to gain access to the set-up parameters. 
 
Note:  Passcode entry is only in effect when the “Set-up Enable” 
selector switch is in the “Disable” position. 
 
If an invalid value is entered, the passcode value will not be reset and 
a message box notifying the user of the error is displayed. 
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________________________________________________________ 
4.4 THE VIEW MENU 
 
The “View” menu allows the user to perform the following functions: 
 
• View the “Target Board Interface” 
• View “Online” Data 
• View “Offline” Data 
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________________________________________________________ 
4.4.1 TARGET BOARD INTERFACE 
 
This function allows the user to view fault codes, S3000 network 
communication error codes and review the current “Ident” and 
“Revision” of the application program.  This is accessed by the 
“View” menu, by selecting “Target Board Interface”. 
 
Once invoked, the set-up program will prompt the user to select a 
program to compare with the one existing in the processor.  Whether a 
program is selected or the user cancels, the setup program will attempt 
to communicate with the M4500.  If unsuccessful, a warning message 
will be displayed, prompting the user to either “Retry” or “Cancel” the 
operation.  If the operation is canceled and communication with the 
processor cannot be established the system will be placed in an 
“Offline” mode, however the “Target Board Interface” window will 
be displayed. 
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________________________________________________________ 
4.4.2 VIEW ONLINE DATA 
 
This function allows the user to place the set-up program in an 
“Online” mode with the processor.  This is accessed by the “View” 
menu, by selecting “Online Data” or by simply pressing the “F3” 
function key. 
 
Note:  The program can be toggled between “Offline” and “Online” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will attempt to open the Comm port 
and communicate with the M4500.  If the set-up program is 
unsuccessful, a warning message will be displayed prompting the user 
to either “Retry” or “Cancel” the operation.  If the operation is 
canceled and communication with the processor cannot be established 
the system will be placed in an “Offline” edit mode. 
 
Note:  Anytime while the set-up program is “Online” with the 
processor and communication is interrupted, a warning message will 
be displayed, prompting the user to either “Retry” or “Cancel” the 
operation. 
 
 
________________________________________________________ 
4.4.3 VIEW OFFLINE DATA 
 
This function allows the user to place the set-up program in an 
“Offline” mode.  This is accessed by the “View” menu, by selecting 
“Offline Data” or by simply pressing the “F4” function key.  This 
allows the user to perform “Offline” editing.  All values displayed in 
“Offline” edit mode reflect the actual values contained in the currently 
loaded set-up data file. 
 
Note:  The program can be toggled between “Online” and “Offline” 
by simply double clicking on the “Online” or “Offline” panel 
displayed in the status bar at the bottom of the window. 
 
Once invoked, the set-up program will close the Comm port and cease 
communication with the M4500. 
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________________________________________________________ 
4.5 THE WINDOW MENU 
 
The “Window” menu allows the user to select one of five different 
Display/Set-up windows to modify set-up parameters, view shift data 
or receive feedback about the current status of the control system. 
 

 
 
Once a window menu item is selected, a check mark is placed next to 
the selected item and the selected window is displayed with the name 
changed in the title bar of the main window. 
 
Note:  “Read” only variables are displayed in blue with a gray 
background.  Any variables that can be altered by the user are 
displayed in black with a white background.  In most cases, a 
parameter that can be changed by the user will have associated with it 
increment and decrement controls.  The user can either click on the 
desired parameter to adjust and enter in a new value, or use the 
increment or decrement controls to change the value by 1 unit. 
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________________________________________________________ 
4.5.1 THE MAIN DISPLAY WINDOW 
 
The “Main Display” window is used to display the general state of the 
control system.  This window is selected from the “Window”. 
 

 
 
The following is a list of the functions of the “Main Display” window. 
 
Messages:  The “Messages” display is continuously updated.  It 
displays alarm and status messages specific to the M4500, as well as, 
the current “Online” or “Offline” status of the set-up program.  By 
simply scrolling the display, the user is able to view all active alarm 
and status messages.  If no alarm or status messages are active, a 
default message is displayed. 
 
Machine CPM:  This display is only active while “Online” and 
displays the current speed of the machine in “Cans Per Minute”. 
 
Good Cans:  This display is the “Current Shift” good can count.   
 
Blow-offs:  This display is the “Current Shift” total blow-off count. 
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Q.C. Blow-off:  This display is only active while “Online” and it 
allows the operator to perform a “QC Select-A-Can” blow-off.   
• The operator can perform a “Single” blow-off by entering in the 

desired spindle number and clicking the “Single Blow-off” 
command button.  

• The operator can perform a “Blanket” blow-off by clicking the 
“Blanket Blow-off” command button.  The blanket blow-off will 
initiate a blow-off sequence such that a can printed by each 
blanket is blown off at the QC blow-off port, starting with a can 
printed by blanket #1. 

• The operator can perform a “Mandrel” Blow-off by clicking the 
“Mandrel Blow-off” command button.  The mandrel blow-off will 
initiate a blow-off sequence such that a can printed on each 
mandrel will be consecutively blown off at the QC blow-off port, 
starting with mandrel #1. 

 
Bad Can Blow-off:  This display is only active while “Online” and 
it allows the operator to test the action of the control system by 
electronically inducing a mis-loaded or “Bad Can” into the system.  
By clicking on the Test Trip/Blow-off command button, a “Bad Can” 
will be electronically induced into the system to test the response of 
the control system due to a “Mis-Loaded” can. 
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________________________________________________________ 
4.5.2 THE SETUP PARAMETERS WINDOW 
 
The “Set-up Parameters” window is used to view and adjust any of the 
set-up parameters.  This window is selected from the “Window” 
menu. 
 

 
 
This window utilizes a “TAB” control to divide the set-up parameters 
into two categories, similar to that of the Keypad/Display. 
 
Print Trip/Varnish Trip:  This section is used to set the print trip 
“Retract/Extend” response times and the varnish unit 
“Retract/Extend” response times in the M4500.  This section contains 
the following selections: 
 
1) Print Trip Retract (out) Response Time (msec): This is the 

time used as the retract response time of the print trip (time from 
solenoid actuation to first break with blanket) in milliseconds. The 
HSL-CCSD1 will activate the retract solenoid this amount of time 
ahead of the Print trip timing (CH00) (usually set at 20 
milliseconds). 
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2) Print Trip Extend (in) Response Time (msec): This is the 
time used as the extend response time of the print trip (time from 
solenoid actuation to first contact with blanket) in milliseconds. 
The HSL-CCSD1 will activate the extend solenoid this amount of 
time ahead of the Print trip timing (CH00) (usually set at 20 
milliseconds). 

 
3) Varnish Trip Retract (out) Response Time (msec): This is 

the time used as the retract response time of the varnish trip (time 
from solenoid actuation to first break with varnish wheel) in 
milliseconds. The HSL-CCSD1 will activate the extend solenoid 
this amount of time ahead of the Varnish unit trip timing (CH01) 
(usually set at 20 milliseconds). 

 
4) Varnish Trip Extend (in) Response Time (msec): This is 

the time used as the extend response time of the varnish trip (time 
from solenoid actuation to first contact with varnish wheel) in 
milliseconds. The HSL-CCSD1 will activate the extend solenoid 
this amount of time ahead of the Varnish unit trip timing (CH01) 
(usually set at 20 milliseconds). 

 
Note: All response times entered must be in the range of 5 to 65 
milliseconds. 

 
5) Number of Shifts to Varnish Unit: This is the number of 

spindles from the Can Sensor to the varnish unit minus 2. In 
general this is set such that the varnish unit retracts out on the can 
ahead of the misloaded spindle. This is set to “5”. 
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Blow-off Parameters:  This section is used to set the “Pin 
Chain/QC Blow-off” parameters in the M4500.  This section contains 
the following selections: 
 

 
 
Note:  The “Bad Can Blow-off” command button will electronically 
induce a mis-loaded can into the system, as well as, the “Q.C. Can 
Blow-off” will blow-off a can printed on spindle #1 at the QC blow-
off port. 
 
1) Number of Pins to Pin Chain Blow-off Port:  This is the 

number of pins from the spindle wheel to disk transfer location to 
the first can blown off at the Pin Chain blow-off port minus two.  
This can be a number from 0 to 999. 

 
2) Number of Cans to Blow-off for Each Mis-load: This is the 

number of cans blown off at the pin chain port when one mis-
loaded can is detected (typically set at 1 can). 

 
3) Number of Cans to Blow-off at Infeed Open: This is the 

number of cans which will be blown off when the infeed is first 
opened.  To blow off no cans at infeed open, set equal to 0, to 
blow off one can set equal to 1, etc. 
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4) Number of Cans to Blow-off from Print at Restart: This is 
the number of cans which will be blown off from the print station 
when the machine is restarted.  To blow off no cans at restart, set 
equal to 0, to blow off one can set equal to 1, etc. 

 
5) Number of Cans to Blow-off from Varnish at Restart: 

This is the number of cans which will be blown off from the 
varnish station when the machine is restarted.  To blow off no 
cans at restart, set equal to 0, to blow off one can set equal to 1, 
etc. 

 
6) Q.C. Can Blow-off Port Shift Offset: This is the number of 

spindles difference from detection of the spindle #1 flag to the QC 
blow-off port.  This is a number between 1 and 24 and is 
empirically set by selecting spindle #1 for blow-off and adjusting 
this value until the can from spindle #1 is the can that is blown 
off. 

 
7) Bad Can Blow-off Solenoid “ON” Response Time: This is 

the time used as the “on” response time of the pin chain blow-off 
port (time from “on” solenoid actuation to first air out port) in 
milliseconds.  The M4500 will activate the solenoid “ON” this 
amount of time ahead of the Pin Chain blow-off “ON” position 
(usually set at 15 to 20 milliseconds). 

 
8) Bad Can Blow-off Solenoid “Off” Response Time: This is 

the time used as the “off” response time of the pin chain blow-off 
port (time from “off” solenoid actuation to air stopping at port) in 
milliseconds.  The M4500 will activate the solenoid “OFF” this 
amount of time ahead of the Pin Chain blow-off “ON” position 
(usually set at 15 to 20 milliseconds for double acting solenoids 
and set at 25 to 30 milliseconds for single acting solenoids). 

 
9) Q.C Can Blow-off Solenoid “ON” Response Time: This is 

the time used as the “on” response time of the QC blow-off port 
(time from “on” solenoid actuation to first air out port) in 
milliseconds.  The M4500 will activate the solenoid “ON” this 
amount of time ahead of the QC blow-off timing “ON” position 
(usually set at 15 to 20 milliseconds). 
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10) Q.C. Can Blow-off Solenoid “Off” Response Time: This 
is the time used as the “off” response time of the QC blow-off port 
(time from “off” solenoid actuation to air stopping at port) in 
milliseconds.  The M4500 will activate the solenoid “OFF” this 
amount of time ahead of the QC blow-off timing “ON” position 
(usually set at 15 to 20 milliseconds for double acting solenoids 
and set at 25 to 30 milliseconds for single acting solenoids). 

 
 
________________________________________________________ 
4.5.3 THE MACHINE TIMING WINDOW 
 
The Machine Timing window is used to invoke the PLS programming 
command menus.  From this window, the user can view or adjust the 
following parameters: 
 
• Adjust Timing Channel setpoints. 
• Set the Main Crank resolver offset. 
• Clear or Recall a PLS timing channel. 
• View the current PLS configuration 
• Reset the PLS configuration to default settings. 
 

 
 



SECTION 4 
CCSD WINDOWS BASED 
SETUP PROGRAM REFERENCE 

 
HSL-CCSD1 User’s Manual SYSTEMS Electronics Group 

 
- 66 - 

In addition, the following parameters are displayed at the bottom of 
this window: 
 
RPM:  This is the current speed in “Revolutions per Minute” of the 
main crank resolver. 
 
Position:  This is the current “Position” in degrees of the main crank 
resolver. 
 
Offset:  This is the current resolver offset (set in degrees). 
 
Scale:  This is the scale factor of the resolver or the number of 
divisions in one revolution. 
 
Note:  The General Timing Signal Locations section provides a 
complete description of each timing channel signal. 
 
 
Zeroing the Machine (setting the resolver offset):  To set 
machine zero, perform the following: 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4500.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and place 
the system into an “Online” mode of operation. 

 
4) Observe the “Position” field at the bottom of the window.  Verify 

that as the machine is rotated forward, that the position increases 
linearly from 0 through 359 degrees.  If not, swap the S1 and S3 
leads at the resolver connector on the M4500.  Then, verify that 
the position does indeed increase with forward movement. 

 
5) Position the machine at machine zero (see section 3.5.4 – Zero 

Machine, Set Resolver Offset). 
 
6) Auto zero the resolver by entering “0” in the “Resolver Offset” 

field and clicking the “Set Offset” command button.  A message 
box will appear, prompting the user to confirm their choice.  
Select “Yes” to set the resolver offset. 
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7) The M4500 will calculate the actual offset value required to make 
this the “0” position.  The new offset value will be displayed in 
the “Offset” field and the position will then read zero. 

 
 
Adjusting the Timing Channel Setpoints:  To set any of the 
timing signal setpoints, perform the following: 
 
Note:  Any changes made to the timing channel setpoints will be 
saved as part of the setup data file. 
 
1) Connect an RS-232 SYSdev cable from the COM port on the 

computer to the “PROG” port on the M4510.   
 
2) From the “Window” menu, select “Machine Timing”. 
 
3) From the “View” menu, select “Online Data”.  The set-up 

program will attempt to communicate with the processor and place 
the system into an “Online” mode of operation. 

 
4) Set all channels per section 6, General Timing Signal Locations.  

Setpoints for a particular channel are either entered in the field or 
adjusted by using the increment/decrement controls. 

 
Note:  Only one set-point is used per channel.  

 
5) If a channel needs to be “Recalled” or “Cleared”, enter the desired 

channel number into the “PLS Channel” field.  Click the “Recall 
Channel” command button to recall the setpoints.  Click the 
“Clear Channel” command button the completely clear all 
setpoints for the selected channel. 

  
 Note:  If a channel has been cleared or the “On” and “Off” 

setpoints have the same setting, the set-point will be displayed as 
“*****”. 

 
Resetting the PLS Configuration:  As an aid to the user the 
current PLS configuration is displayed in the “PLS Configuration” tab 
of this window.  The PLS configuration should only be reset if a new 
module has been installed.  To reset the PLS configuration, click the 
“Reset PLS Config” command button.  This function only resets the 
PLS configuration to the default settings. 
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________________________________________________________ 
4.5.4 THE SHIFT DATA WINDOW 
 
The “Shift Data” window is used to view the shift data collected by 
the M4500.  This window is selected from the “Window” menu. 
 

 
 
This window utilizes a “TAB” control to divide the set-up parameters 
into three categories, similar to that of the Keypad/Display.  These 
sections are as follows: 
 
Trips per Spindle: The Number of trips per spindle display is 
provided to aid in the trouble-shooting of a loading problem with a 
spindle or spindles.  The total number of trips for each spindle since 
the last reset or end of shift is displayed.  The operator can reset these 
counts at anytime to aid in the trouble-shooting process.   
 
The following data is displayed in the “Trips per Spindle” section: 
 
1) Spindle #1 Trip Offset:  The “Spindle Trip Offset” can be 

entered from this section.  This is used to compensate for the 
location of the can/no can sensor and the spindle #1 I.D. sensor 
location.  Use the “Tripped Spindle” display to adjust the offset 
value.  Follow the procedure outlined in section 2.10.10 – Set 
Spindle Trip Offset. 
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2) Spindle #xx Trips: This is the total number of trips for each 

spindle. This data is displayed and updated continuously in the 
respective field for each spindle.  A disproportionately high count 
for a particular spindle indicates a loading problem for that 
spindle. 

 
Current Shift Data:  This section is used to view the “Current 
Shift” data.  This data is the totals so far into the shift.  This data is 
transferred to the “Last shift” at the end of either an 8 or 12 hour shift 
or alternatively could be done at label changes such that the data 
collected would be for label runs rather than complete shifts.  This 
data can be reset by the user from this section. 
 

 
 
Note:  The “Transfer Data” command button is only active while 
“Online”.   
 
1) Total Good Cans: This is the total number of good cans printed 

so far into the shift.  This is essentially a can counter. 
 
2) Total Blow-offs: This is the total number of cans blown-off the 

machine.  This includes all types of blow-offs: the can(s) blown-
off for each mis-load, infeed open blow-offs, restart blow-offs, 
manual blow-offs, select-a-can QC blow-offs, etc. 
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3) Total Bad Cans or Mis-loads: This is the total number of mis-
loaded cans (trips). These would be the actual number of damaged 
cans that did not load properly on the machine.  This gives an 
indication of conveying/can handling problems. 

 
4) Manual Blow-offs: This is the total number of cans blown-off 

by the operator using the Manual Blow-off PB or selector switch. 
 
5) QC Blow-offs: This is the total number of cans blown-off by the 

operator with the Select-A-Can QC station or QC Blow-off key on 
the M4500 keypad for quality verification. 

 
6) Restart Blow-offs: This is the total number of cans blown off 

when the infeed opened and from the print station and varnish 
station at machine restart. 

 
7) DrvSide Trips: This is the total number of misloads on the drive 

side.  This is only incremented once for every misload on a drive 
side spindle. 

 
8) OffSide Trips: This is the total number of misloads on the 

offside.  This is only incremented once for every misload on a 
offside spindle. 

 
9) Drive Side Misloads per Spindle (1:-24:): This is the total 

trips (mis-loads) for each spindle on the drive side.  A 
disproportionately high count for a particular spindle indicates a 
loading problem for that spindle. 

 
10) Offside Misloads per Spindle (1:-24:): This is the total trips 

(mis-loads) for each spindle on the offside.  A disproportionately 
high count for a particular spindle indicates a loading problem for 
that spindle. 

 
 Note: When a misload occurs, it is only counted on the spindle of 

the spindle of the side that it on. 
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Last Shift Data:  The “Last Shift” data is identical to the current 
shift data except it is for the previous 8 or 12 hour shift or previous 
label run, however the shift collection is set-up.  This allows data 
collection and diagnostics to take place automatically over a two shift 
period. 
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________________________________________________________ 
4.5.5 THE I/O STATES WINDOW 
 
The “I/O States” window is provided to display states of the inputs 
and outputs.  The control boards, the states of the timing channels, as 
well as states of the M4500 are shown.  This includes the interrupt 
inputs (IN0 and IN1), the analog I/O and the resolver.  These values 
are displayed as read by the M4500 processor. 
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The DOS based “HSLCCSD1” set-up program is menu driven, 
allowing the user to easily view data, alter set-up variables and set the 
machine timing (machine offset, timing signal locations, etc.) using a 
laptop or personal computer. The set-up variables are used to 
configure and tune the HSLCCSD1 to match the configuration and 
performance of the specific decorator (see Tuning the HSL-CCSD1, 
section 2.10). 
 
The main menu of the “HSLCCSD1” set-up program incorporates the 
following menu selections: 
 

 
 
Note: The “HSLCCSD1” program is an on-line communications 
program used to interface with the M4500 module. The data displayed 
in the menus and set in the menus is communicated directly to the 
M4500. Therefore, prior to selecting any of the above selections, 
make sure an RS-232 cable is connected from the COM port on the 
computer running “HSLCCSD1” to the “PROG” port on the M4500. 
 
The following sections are a complete description of the 
“HSLCCSD1” selections and menus. 
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________________________________________________________ 
5.1 SET PRINT/VARNISH RESPONSE TIMES 
 
This selection is used to set the print and varnish trip response times 
in the M4500. When selected, the “Print/Varnish Trip Set-up” menu is 
invoked.  
 
The “Print /Varnish Trip Set-up” menu contains the following 
selections: 
 

 
 
The following selections set the corresponding parameters: 
 
 
________________________________________________________ 
5.1.1 SET PRINT TRIP EXTEND/RETRACT RESPONSE 
TIMES 
 
Print Trip Retract Response Time: This is the time used as the 
retract response time of the print trip (time from solenoid actuation to 
first break with blanket) in milliseconds. The M4500 will activate the 
retract solenoid this amount of time ahead of the Print unit trip timing 
(CH00, usually set at 20 milliseconds). 
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Print Trip Extend Response Time: This is the time used as the 
extend response time of the print trip (time from solenoid actuation to 
first contact with blanket) in milliseconds. The M4500 will activate 
the extend solenoid this amount of time ahead of the print trip timing 
(CH00, usually set at 20 milliseconds). 
 
 
________________________________________________________ 
5.1.2 SET VARNISH TRIP EXTEND/RETRACT RESPONSE 
TIMES 
 
Varnish Trip Retract Response Time: This is the time used as 
the retract response time of the varnish trip (time from solenoid 
actuation to first break with varnish wheel) in milliseconds. The HSL-
CCSD1 will activate the retract solenoid this amount of time ahead of 
the Varnish trip timing (CH01) (usually set at 20 milliseconds). 
 
Varnish Trip Extend Response Time: This is the time used as 
the extend response time of the varnish trip (time from solenoid 
actuation to first contact with varnish wheel) in milliseconds. The 
HSL-CCSD1 will activate the extend solenoid this amount of time 
ahead of the Varnish trip timing (CH01) (usually set at 20 
milliseconds). 
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________________________________________________________ 
5.2 Set Pin Chain/QC Blow-off Parameters 
 
This selection is used to set the pin chain/QC blow-off parameters in 
the HSL-CCSD1. When selected, the “Pin Chain/QC Blow-off Set-
up” menu is invoked.  
 
The “Pin Chain/QC Blow-off Set-up” menu contains the following 
selections: 
 

 
 
The following selections set the corresponding parameters: 
 
 
________________________________________________________ 
5.2.1 SET BAD CAN (PIN CHAIN) BLOW-OFF RESPONSE 
TIMES 
 
Bad Can Blowoff Solenoid “On” Response Time: This is the 
time used as the “on” response time of the pin chain blow-off port 
(time from “on” solenoid actuation to first air out port) in 
milliseconds. The M4500 will activate the solenoid this amount of 
time ahead of the Pin Chain blow-off timing (CH05, usually set at 15 
to 20 milliseconds). 
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Bad Can Blowoff Solenoid “Off” Response Time: This is the 
time used as the “off” response time of the pin chain blow-off port 
(time from “off” solenoid actuation to air stopping at port) in 
milliseconds. The M4500 will activate the solenoid this amount of 
time ahead of the Pin Chain blow-off timing (CH05, usually set at 15 
to 20 milliseconds for double acting solenoids and set at 25 to 30 
milliseconds for single acting solenoids). 
 
 
________________________________________________________ 
5.2.2 SET NUMBER OF CANS TO BLOW-OFF PIN CHAIN 
 
# Of Bad Cans To Blowoff For Misload: This is the number of 
cans blown off at the pin chain port when a mis-loaded can is detected 
(typically set at 1 can). 
 
# Of Cans To Blowoff From Infeed Open: This is the number of 
cans which will be blown off when the infeed is first opened. To blow 
off no cans at infeed open, set equal to 0, to blow off one can set equal 
to 1, etc. 
 
# Of Cans To Blowoff From Print At Restart: This is the 
number of cans which will be blown off from the print station when 
the machine is restarted. To blow off no cans at restart, set equal to 0, 
to blow off one can set equal to 1, etc. 
 
# Of Cans To Blowoff From Varnish At Restart: This is the 
number of cans which will be blown off from the varnish station when 
the machine is restarted. To blow off no cans at restart, set equal to 0, 
to blow off one can set equal to 1, etc. 
 
 
________________________________________________________ 
5.2.3 SET NUMBER OF PINS TO PIN CHAIN BLOW-OFF 
PORT 
 
# Of Pins To Pin Chain Blowoff Port: This is the number of pins 
from the spindle wheel to linear vacuum conveyor transfer location to 
the first can blown off at the Pin Chain blow-off port minus two. This 
can be a number from 0 to 999. 
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________________________________________________________ 
5.2.4 SETUP QC (SELECT-A-CAN) BLOW-OFF 
 
QC Can Blowoff Solenoid “On” Response Time: This is the 
time used as the “on” response time of the QC blow-off port (time 
from “on” solenoid actuation to first air out port) in milliseconds. The 
M4500 will activate the solenoid this amount of time ahead of the QC 
blow-off timing (CH06, usually set at 15 to 20 milliseconds). 
 
QC Can Blowoff Solenoid “Off” Response Time: This is the 
time used as the “off” response time of the QC blow-off port (time 
from “off” solenoid actuation to air stopping at port) in milliseconds. 
The M4500 will activate the solenoid this amount of time ahead of the 
QC blow-off timing (CH06, usually set at 15 to 20 milliseconds for 
double acting solenoids and set at 25 to 30 milliseconds for single 
acting solenoids). 
 
QC Can Blowoff Port Shift Offset: This is the number of 
spindles difference from detection of the spindle #1 flag to the QC 
blow-off port. This is a number between 1 and 24 and is empirically 
set by selecting spindle #1 for blow-off and adjusting this value until 
the can from spindle #1 is the can that is blown off. 
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________________________________________________________ 
5.3 SET MACHINE TIMING 
 
The Set Machine Timing selection is used to invoke the PLS 
programming command menus. When selected, the PLS programming 
main development menu will be invoked using the default 
“CCSD2TMG” channel set-point file. From this menu, the user can 
zero the machine (set the resolver offset) and adjust the timing 
channel set-points. The following sections describe how to perform 
these functions. Section 6 provides a complete description of each 
timing signal. 
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________________________________________________________ 
5.3.1 ZEROING THE MACHINE 
 

 
 
To set the machine zero (resolver offset) perform the following: 
 
1) Select the “3: Set Machine Timing” selection from the HSL-

CCSD1 set-up program main menu. 
 
2) Select “1: Online Channel Setpoint Programming” from the Main 

Development menu. 
 
3) Select “F9: POS/RPM” and observe the “POS:” field. Verify that 

as the machine is rotated forward (either jogging or barred) that 
the position increases linearly from 0 through 359. If not, swap the 
S1 and S3 leads of the resolver at the HSL-CCSD1 resolver 
connector. Then verify that the position then indeed does increase 
with forward movement. Press <ESC> to exit the “POS/RPM” 
update. 

 
4) Position the machine at machine zero (spindle centered on No 

Can/No Print sensors). 
 
5) Auto zero the resolver by selecting “F10: Set Offset”. Enter “0” in 

the offset field and press <ENTER>. 
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6) The M4500 will calculate the actual offset value required to make 
this the 000 position and will display this number in the offset 
field. The position will now read 0. 

 
7) Exit back to the PLS Main Development menu by pressing 

<ESC>.  
 
 
________________________________________________________ 
5.3.2 ADJUSTING THE TIMING CHANNEL SET-POINTS 
 
To set or alter any of the timing signal set-points, perform the 
following: 
 
1) Select the “3: Set Machine Timing” selection from the HSL-

CCSD1 set-up program main menu. 
 
2) Select “1: Online Channel Setpoint Programming” from the Main 

Development menu. 
 
3) Set all channels per section 6. Set-points are entered for a 

particular channel simply by typing in the set-point in the form 
XXX-YYY<ENTER> in the first set-point of the given channel  

 
Note: For the decorator only one set-point is used per channel and 
this should be entered in the number 1 set-point.  
 
The XXX is the location the set-point will turn “on” while YYY is 
the location where the set-point will turn “off”. Use the PgUp, 
PgDn, F1:Next Chan, or F2: Prev Chan keys to select the desired 
channel for programming. 

 
4) Once all channels are programmed, press <ESC> to exit back to 

the PLS Main Development Menu.  
 

Note: The new channels will be saved both in the module and in 
the “CCSD2TMG” file. 
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________________________________________________________ 
5.4 DOWNLOAD PROGRAM TO MODULE 
 
This selection is used to download the HSLCCSD1 application 
program to the M4500 module. This should only be performed when 
replacing the module or when changes to the program have been 
made. To download the program, perform the following: 
 
1) Select “4: Download Program to Module” from the Main Menu. 

The current program ident, revision, and checksum for both the 
program on disk and already loaded in the module will be 
displayed. A prompt will be displayed asking to continue or abort. 
To continue, press any key except the <ESC> key. To abort, press 
the <ESC> key. If a prompt stating that the “HSLCCSD1” file 
could not be opened is displayed, then the “HSLCCSD1” 
application program is not installed in the current directory. 

 
2) Once program download is initiated, program execution will 

cease, the current address being downloaded will be displayed and 
the “RUN” LED on the module will flash continuously. 

 
3) Once the download is complete, the “RUN” LED on the module 

will illuminate solid and program execution in the M4500 will 
resume. Press any key to return back to the main menu. 

 
Note: This selection can also be used to verify the program ident, 
revision, and checksum without downloading the program. Perform 
step 1 above but instead of initiating the download, simply press the 
<ESC> key to abort the download once the ident, revision, and 
checksum have been displayed. 
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________________________________________________________ 
5.5 DOWNLOAD SET-UP DATA TO MODULE 
 
This selection is used to download the previously uploaded (saved) 
set-up variables to the HSL-CCSD1 module. This should only be 
performed when replacing the module.  
 
Note: The set-up data consists of the print/varnish response times, 
pin chain/QC blow-off parameters and the spindle trip shift offset. 
Timing channel set-points are not stored as part of the set-up data, 
these are stored in the “CCSD2TMG” file.  
 
To download the set-up data, perform the following: 
 
1) Select “5: Download Set-up data to Module”. A prompt will be 

displayed asking to continue or abort. To continue, press any key 
except the <ESC> key. To abort, press the <ESC> key. 

 
2) Once data download is initiated, the current address being 

downloaded will be displayed.  
 

Note: Program execution is not ceased, therefore data download 
can be performed while the machine is running. 

 
3) Once set-up data download is complete, press any key to return to 

the main menu. 
 
 
________________________________________________________ 
5.6 UPLOAD (SAVE) SET-UP DATA FROM MODULE 
 
This selection is used to save the set-up variables from the HSL-
CCSD1 module to the hard drive (current directory selected). This 
should be performed anytime any of the set-up variables have been 
changed.  
 
Note: When the set-up variables are changed, they are changed 
directly in the module, not on the file in the computer. By uploading 
(saving) the set-up variables to disk, they can be downloaded to the 
module in the event the module must be replaced. 
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The set-up data consists of the print/varnish response times, pin 
chain/QC blow-off parameters and the spindle trip shift offset. Timing 
channel set-points are not stored as part of the set-up data, these are 
stored in the “CCSD2TMG” file. To upload the set-up data, perform 
the following: 
 
1) Select “6: Upload (Save) Set-up data from Module”. A prompt 

will be displayed asking to continue or abort. To continue, press 
any key except the <ESC> key. To abort, press the <ESC> key. 

 
2) Once data upload is initiated, the current address being uploaded 

will be displayed.  
 

Note: Program execution is not ceased, therefore data upload can 
be performed while the machine is running. 

 
3) Once set-up data upload is complete, press any key to return to the  

main menu. 
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The following is a general description of the timing signals and the 
locations they should be set at: 
 
CH00: Print Trip: This signal should just turn “on” when a blanket 

is in between spindles (previous can has been completely 
printed, next spindle has not yet made contact with the pre-
spin of the blanket it is to be printed on). The leading edge of 
this timing signal is used to both extend and retract the print 
so the width of the timing signal is not critical. This signal 
should be 40 degrees wide. 

 
CH01: Varnish Trip: This signal should just turn “on” when the 

varnish wheel is in between spindles (previous can has been 
completely varnished and is no longer in contact with the 
varnish wheel, next spindle has not yet made contact with 
the pre-spin of the varnish wheel). The leading edge of this 
timing signal is used to both extend and retract the varnish 
so the width of the timing signal is not critical. This signal 
should be 40 degrees wide. 

 
CH02: Can/No Can Clock: This signal is used to clock the bad 

can shift register which activates the print, varnish, and pin 
chain blow-off for mis-loaded cans. It is also used as a 
general purpose clock for all shift registers, counters, etc. 
The can/no can clock is generally set “on” at 180 degrees 
and “off” at 000 degrees. The “off” to “on” transition of 
CH02 cannot however coincide with either the CH00 (Print 
trip), CH01 (Varnish trip), CH04 (Damaged (Hi)), or CH05 
(Pin Chain Blow-off) timing signals. These timing signals 
must be set at least 20 degrees ahead or behind the CH02 
“off” to “on” transition. 

 
CH03: Damaged Can Blowoff (Lo) Timing: This signal is used 

to activate the damaged can blowoff solenoid at low speeds 
(below 1300CPM). The damaged can blowoff “on” solenoid 
will actually be “on” for the duration of CH03 when a mis-
loaded can is detected. This signal should be set “on” 10 
degrees after air starts to leave the damaged can port and set 
“off” 180 degrees before air stops leaving the port. 
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CH04: Damaged Can Blowoff (Hi) Timing: This signal is used 
to activate the damaged can blowoff solenoid at high speeds 
(above 1300CPM). The damaged can blowoff “on” solenoid 
will actually be “on” for the duration of CH04 when a mis-
loaded can is detected. This signal should be set “on” 40 
degrees before CH03 turns “on” and set “off” 10 degrees 
before CH03 turns “off”.  

 
 Note: The No Can/No Print sensors must normally first see 

a good can at least 30 degrees prior to the “off” to “on” 
transition of CH04, if not retard both CH03 and CH04 as 
necessary. CH04 is the timing channel that actually clocks in 
the good can/bad can data from the No Can/No Print 
sensors. 

 
CH05: Pin Chain (Bad Can) Blow-off Timing: This should 

turn “on” when the chain blow-off port is centered between 
cans on the linear vacuum conveyor. This signal should be 
40 degrees wide. 

 
CH06: QC (Select-A-Can) Blow-off Timing: This should turn 

“on” when the select-a-can chain blow-off port is centered 
between cans on the linear vacuum conveyor. This signal 
should be 40 degrees wide. 

 
CH07: Spare Timing: This signal is not used internally by the 

HSL-CCSD1 but must have a set-point in it to satisfy the 
timing signal failure detection. Set “on” at 000 and “off” at 
040. 

 
CH10: PLC Clock Timing: This signal is provided to the PLC via 

a discrete DC output. This is used for whatever purpose 
required by the host PLC to clock once per spindle data. In 
general this should be set “on” for 180 degrees and “off” for 
180 degrees. Otherwise set as desired. This signal is not used 
by the HSL-CCSD1 package internally in any way. 
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The following are recommended spares for the HSL-CCSD1. These 
parts are available through Systems Engineering Assoc. Inc. 
 
 Quantity Part Number Description 
 
 1ea. M4500 PLC/PLS Processor/Chassis – 4 

Slot 
 1ea. P4500 Power Supply 
 1ea. S4563 16 Point 10-30VDC Input Board 
 1ea. S4568 8 input/8 output 10-30VDC I/O 

Board 
 1ea. S4573 16 point 10-30VDC Output 

Board 
 1ea. D4591 Display/Keypad 
 
 


